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About this workbook 

 

Welcome to this Infor Education course! We hope you will find this learning experience enjoyable and 
instructive. This Training Workbook is designed to support the following forms of learning: 

 Classroom instructor-led training 

 Virtual instructor-led training 

This Training Workbook is not intended for self-study or as a product user guide. 

Activity data 

You will be asked to complete some practice exercises during this course. Step-by-step instructions are 
provided in this guide to assist you with completing the exercises. Where necessary, data columns are 
included for your reference. 

Your instructor will provide more information on systems used in class, including server addresses, login 
IDs and passwords. 

Reference materials 

Infor BI reference materials are available from the following locations:  

 Infor BI Help menu 

 Infor Xtreme 

Symbols used in this workbook 
 

 

Hands-on exercise 
(“Exercise”) 

 

For your reference 

 

Instructor demonstration 
(“Demo”) 

 

Your notes 

 

Can be used for either 
“Scenario” or “Discussion” 

 

Question 

 

Note 

 

Answer 
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Course overview 

Course duration 

2 days 

Learning objectives 

Upon completion of this course, you will be able to:  

 Identify the basic features and functionality of Office Plus. 

 Explain how to log on to Office Plus and identify the main components of the user interface. 

 Describe how to create ad hoc reports and browse through data. 

 Explain how to use the List Designer to select, sort, and filter data. 

 Explain how to write values back to base cells and aggregated cells. 

 List the steps to create formula reports. 

 List the steps to create Alea ad hoc reports.   

 Explain how to use attribute tables, global lists, calculations, and style templates. 

Audience 
 Customer User  

 Pre-Sales Consultant  

 Business Consultant  

 Technical Consultant  

 Support 

 System Administrator  

System requirements 
 Infor BI Training Environment 
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Course description and agenda 

This course introduces the basic features of Infor BI Office Plus and provides learners with the 
foundational knowledge needed to generate and customize ad hoc and formula reports.  
 
 
Prerequisite knowledge 
To optimize your learning experience, Infor recommends that you have the following knowledge prior to 
attending this course: 

 Basic knowledge of Microsoft® Windows®  

 Basic knowledge of Microsoft® Excel® 
 

Lesson Lesson title Learning objectives Day 

Course overview  Review course expectations. Day 1 

Lesson 1 Lesson 1: Office 
Plus overview 

 List the main components of Infor BI. 

 Identify the features and functionality of 
Infor BI Office Plus. 

 Describe the Infor BI Office Plus 
architecture. 

 Describe repositories, projects, and 
report catalogs. 

 Describe data management in 
spreadsheets. 

 Describe data management in relational 
databases. 

Day 1 

Lesson 2 Getting started  Explain how to log on to Office Plus. 

 List the steps to create a database alias. 

 Identify the main components of the 
Office Plus user interface. 

 Identify the major sections of the Office 
Plus toolbar. 

Day 1 

Lesson 3 Ad-hoc reporting  Describe how to create an ad-hoc report. 

 Define ad-hoc report options. 

 Explain how to use the Ad-hoc Report 
Designer. 

 Describe navigation in an ad hoc report. 

 Explain how to use the Keep Elements 
function. 

 Explain how to suppress zero and empty 
values. 

 List the steps to add a chart to an ad-hoc 
report. 

 Explain how to save an ad-hoc report. 

Day 1 

Lesson 4 Using the List 
Designer 

 Describe the functionality of the List 
Designer. 

 Identify the List Designer panes. 

 Explain how to select elements to display 
in a list. 

Day 1 
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Lesson Lesson title Learning objectives Day 

 Explain how to filter data within a list. 

 Explain how to sort data within a list. 

 List the steps to display attributes for a 
dimension. 

 Describe the options in the Advanced 
pane. 

Lesson 5 Data entry  Explain how write back works. 

 Identify the different write back methods. 

 Describe allocation and alteration. 
 

Day 2 

Lesson 6 Formula reports   Identify the differences between ad-hoc 
reports and formula reports. 

 Identify common Office Plus formulas. 

 Describe query-based, cell-based, Excel-
aggregated, and value-based formula 
reports. 

 List the steps to convert an ad-hoc report 
to a formula report. 

 Explain how to create a formula report 
from a blank Excel worksheet using the 
Formula Wizard. 

Day 2 

Lesson 7 Alea ad-hoc 
reports 

 List the steps to create an Alea ad hoc 
report. 

 Explain how to use the Dimension 
browser. 

 Identify the buttons on the Dimension 
browser. 

 Describe the purpose of the Splasher. 

 Identify the Splasher toolbar buttons. 

 Explain how to insert a cell note. 

 Identify common Alea formulas. 

 Identify the differences between Alea and 
Office Plus formula groups. 

 Explain how to use Alea formulas in a 
report. 

Day 2 

Lesson 8 Using other Office 
Plus features 

 Describe the use of a global list in a 
report. 

 Explain how to use a calculation in a 
report. 

 Explain how to use the Style Wizard to 
create a new template. 

 List the steps to apply a template to a 
report. 

Day 2 

Course summary  Debrief course. Day 2 
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Lesson 1: Office Plus overview 

Estimated time 

1 hour 

Learning objectives 

After completing this lesson, you will be able to: 

 List the main components of Infor BI. 

 Identify the features and functionality of Infor BI Office Plus. 

 Describe the Infor BI Office Plus architecture. 

 Describe repositories, projects, and report catalogs. 

 Describe data management in spreadsheets. 

 Describe data management in relational databases. 

Topics 
 Introduction to Infor BI 

 Introduction to Office Plus 

 Office Plus architecture 

 Basic concepts 
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Introduction to Infor BI 

Infor BI is a fully integrated solution suite that supports various types of financial, operational, and sales 
business intelligence requirements. It can be used for standard reporting, flexible ad-hoc reporting and 
analysis, dashboard creation, business planning, budgeting, forecasting, and financial consolidation.   

 

The following table identifies the components of the Infor BI suite and provides a brief description of each: 

Component Description 

Application Studio A web-based front-end used for visualizing data through reports, 
analysis, dashboards, and data entry 

Office Plus for Microsoft 
Office Excel 

A fully integrated Microsoft Office Excel  add-in mainly used for ad-
hoc analysis and reporting 

OLAP A real-time, in-memory, online, analytical processing (OLAP) 
database server for multidimensional analysis, planning, and 
modeling 

Designer A tool for designing and creating Infor BI OLAP Server databases 

Planning An application for financial, operational, and overall business 
budgeting and forecasting 

Consolidation A statutory and management consolidation application that leverages 
the Infor BI OLAP Server 

ImportMaster An extract, transform, and load (ETL) layer that facilitates integration 
with both Infor and non-Infor source systems 

DeltaMiner A tool providing statistical analysis, data mining, and other advanced 
analytic capabilities 

Business Analytics An application that includes predefined, role-based content for sales, 
finance, production, and other functional areas 
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Introduction to Office Plus 

Infor BI Office Plus for Microsoft Office Excel (Office Plus) provides a powerful, flexible, and customizable 
Microsoft Office Excel add-in used for reporting and analyzing data. By combining the strength and 
advantages of an Excel spreadsheet with the power of a multidimensional database, Office Plus offers 
advanced reporting capabilities and sophisticated information analysis to improve collaboration and 
optimize key business processes. 

Advanced reporting capabilities 

Using existing Excel functions, Office Plus transforms common analytic views into standard reports. Basic 
or complex reports can be created. Excel charts or tables can even be added to these reports and 
connected to existing data sources.  

Sophisticated information analysis 

Sorting, ranking, color coding, and other advanced analytic options in Office Plus allow for the quick 
assessment of business information. And, by dragging and dropping desired elements into Excel using 
the Office Plus ad-hoc reporting feature, you can easily browse through your business data. 

 

 

________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________ 
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Office Plus architecture 

Office Plus is a client/server ad-hoc reporting tool that integrates into Microsoft Excel. It supports 
connections to a variety of data sources through database aliases. The metadata of Office Plus is stored 
in a Microsoft® SQL® Server® database or in an Oracle® database. The business data is stored in an 
OLAP server database. 

A presentation layer in pure HTML, compatible with both Internet Explorer® and Firefox®, is available via 
Application Studio. 

 

 

Office Plus architecture 

 

 

Repository 

One component of Infor BI is the repository. The repository is a store for objects that the various Infor BI 
products have in common. It is created on a SQL database, such as a Microsoft SQL Server or Oracle 
database.  

Office Plus stores the data for connecting to the OLAP Server database, user management, and report 
layout in a central database - the repository. When you start Office Plus, you connect to a repository, and 
select a project and a report catalog. You create a database alias in Office Plus to access an OLAP 
Server. You create reports based on OLAP cube data and store the report definitions in the repository.  

The repository can contain multiple projects. A project contains database aliases, global lists (which can 
also be used in Application Studio), and user rights. A project can contain multiple report catalogs, which 
store and organize multiple reports and templates.  
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Infor BI architecture 
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Basic concepts 

Data management in spreadsheets 

One of the most common uses for a spreadsheet program is to manage lists of data, such as products, 
customers, regions, and revenue. A list is an organized collection of data stored in rows and columns (two 
dimensional). This data can be used for analysis purposes. If you use more than one spreadsheet to 
store data, you can obtain more than two analysis perspectives. 

 

 
Multiple tables in a spreadsheet 

 
 

Disadvantages of spreadsheets  

If you link spreadsheets in your business and send them across departments, you will undoubtedly 
develop problems.  

 

Linked spreadsheets 
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The following are some of the disadvantages of using spreadsheets:  

 Risks:  
o Data redundancy and inconsistency 
o Data inaccuracy, since spreadsheets allow for manually entering data directly into cells 
o Errors when linking numerous tables 

 Lack of usability:  
o Data becomes unusable when tracking down a simple figure requires scrolling through 

hundreds of columns of a spreadsheet 
o Data storage is local with only one write-access possible at the same time 
o Sharing spreadsheets among multiple departments can introduce confusion in determining 

the latest version of data 
o Spreadsheet memory size limits the amount of data  

 Performance and time-consumption:  
o Consolidation creates performance issues and becomes increasingly more time consuming 
o Manual data entry of the same data into multiple spreadsheets is time consuming  

 Data security issues 
 

Data management in relational databases 

In most systems, the master data and transactional data is managed in relational databases. This data is 
stored within many tables, which are related to one other. These types of databases have proven to 
display weaknesses when performing hard-coded analysis or complex queries via Structured Query 
Language (SQL) statements. This is the reason for developing OLAP technology. 

 

 

Data management in relational databases 

 

Disadvantages of a relational database 

 Planning and simulation is difficult 

 Knowledge of specific query language is necessary 

 Structural changes are complex 
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Check your understanding 

 

 

Which of the following is a fully integrated Microsoft Office Excel add-in mainly used for ad-
hoc analysis and reporting? 

a) Infor BI Application Studio 
b) Infor BI Office Plus  
c) Infor BI ImportMaster 
d) Infor BI Designer 
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Lesson 2: Getting started 

Estimated time 

1 hour 

Learning objectives 

After completing this lesson, you will be able to: 

 Explain how to log on to Office Plus. 

 List the steps to create a database alias. 

 Identify the main components of the Office Plus user interface. 

 Identify the major sections of the Office Plus toolbar. 

Topics 
 Logging on to Office Plus 

 Creating database aliases 

 The user interface 
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Logging on to Office Plus 

When you log on to Office Plus you are required to connect to a repository from the Log On dialog box. 
You must then select an existing project and report catalog or add a new project and catalog. 

 

Training repository 

In this course, you will be using the Tutor Repository, which connects to the Tutor_EN (English) database 
with Academy as its database alias. 

 

 

 

Demo: Log on to Office Plus 

Your instructor will demonstrate how to start Office Plus, connect to the Tutor Repository, 
and add a project and report catalog. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 2.1: Log on to Office Plus 

In this exercise, you will start Office Plus, connect to the Tutor Repository, and add a 
project and report catalog. 

Exercise steps 

1. Double-click the Office Plus for Excel icon on the desktop. Microsoft Excel opens displaying an 
Infor BI Office Plus tab.    

2. Click the Infor BI Office Plus tab. 

3. Click the lower portion of the Log On button in the toolbar to display a secondary option. 

4. Select Log On with Options. The Log On dialog box opens. 

5. Use the information provided in the table below to type or select the criteria for log on: 

Authentication Basic 

User Name  Admin 

Password (Leave this field blank) 

Repository Tutor Repository 

6. Click Connect. 

7. Click Add next to the Project field in the Log on dialog box. The Add Project dialog box opens.   
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8. Type <your initials> Ex 2.1 Project in the Name field. 

9. Click OK to return to the Log On dialog box. 

10. Click Add next to the Report catalog field. The Add Report Catalog dialog box opens. 

11. Type <your initials> Ex 2.1 Report Catalog in the Name field. 

12. Click OK to return to the Log On dialog box. 

 

You can also edit an existing project or report catalog by clicking the down arrow on the 
Add button and selecting Edit. 

13. Click OK to log on to Office Plus. 
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Creating database aliases 

Databases are accessed through an alias, so if the database or server name changes, all reports will 
continue to work. The database alias contains the registration information for the data source, including 
the server name, database name, and connection method. The alias is stored in the repository, and is 
available to any user connected to that repository. 

 

 

 

Demo: Create a database alias 

Your instructor will demonstrate how to create a database alias. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 2.2: Create a database alias 

In this exercise, you will create a database alias. 

Exercise steps 

1. Click the New Database Alias button in the Database Structure pane. The New Database 
Alias dialog box opens. 

2. Use the information provided in the table below to type or select the database alias: 

Field name Data 

Name  Academy  

Provider Infor BI OLAP Provider 

Driver XMLA 

3. Click the Advanced tab. 

4. Verify that the Accept self-signed certificates option is set to Yes; otherwise, select it. 

5. Click the Database tab. 

6. Type localhost in the Server field. 

7. Select depm2014/Academy over https from the Database drop-down menu.  

8. Click OK. Note: If an Infor BI Office Plus dialog box appears prompting you to save the log on 
settings, click Yes.   
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The user interface 

The Office Plus user interface consists of the following main components: 

 Office Plus toolbar 

 Database Structure pane 

 Report Catalog pane 

 Properties pane 

 Report area 

 Ad-hoc Report Designer 

 List Designer 

 Preview pane 

 

Office Plus user interface 

 

 

Office Plus toolbar 

The following table identifies the major sections of the Office Plus toolbar and provides a brief description 
of each: 

Toolbar section Description 

Office Plus Log on and off of Office Plus, change your password, create new ad-hoc, 
Alea ad-hoc, and formula reports, save reports, and create a database 
alias 
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Toolbar section Description 

Panes Shows or hides the following panes:  

 Database Structure 

 Report Catalog 

 Ad-hoc Report Designer  

 List Designer 

 Properties 

 Preview 

 All left-docked panes (Database Structure, Report Catalog, and 
Properties panes) 

 All right-docked panes (List Designer and Preview panes) 

Database Opens the Cubes and Data Areas dialog box, opens the Dimensions and 
Subsets dialog box, processes data, and clears cached results of 
DBGETC formulas 

Write Back Perform client-side splashing, lock and unlock cells, set constraints, 
remove all cell locks and constraints, switch between immediate and non-
immediate write back modes, save changed values to a database, and 
refresh data to revert to values from a database 

Ad-hoc Report Convert an ad-hoc report to a formula report, recalculate a report, 
transpose a report, open the Select Slice Dimensions dialog box, suppress 
data, use presentation options, and insert a chart into a report 

Note: This toolbar section will not display until you are working with an ad 
hoc report. 

Alea Ad-hoc Report Opens the Define Alea Ad-hoc Report dialog box allowing you to edit a 
report, recalculate a report, keep elements, and convert an Alea ad hoc 
report to a formula report. 

Note: This toolbar section will not display until you are working with an 
Alea ad hoc report 

Extras Opens the Options dialog box, accesses write back features, such as 
committing and undo changes, and accesses various tools, such as the 
Cube Wizard and Style Wizard. 

Office Plus plugin 
for Microsoft Excel 

Displays Office Plus help, licensing information, and Office Plus version 
and copyright information. 

 

 

Database Structure pane 

The Database Structure pane contains the database objects. This pane displays the repository you are 
logged on to and any database aliases registered in that repository. Expanding the alias will display 
cubes and dimensions within the cube. 

To display the Database Structure pane, do one of the following: 

 Click the Database Structure button in the Panes group of the Office Plus toolbar. 

 Click the Database Structure tab in the left pane. 
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Database Structure pane buttons 

The Database Structure pane buttons vary depending on the level of the database structure you select. 
For example, the Log On and Log Off buttons may refer to logging on and off of a repository or a 
database alias.  

The following table identifies some of the Database Structure pane buttons and provides a brief 
description of each: 

Toolbar section Description 

Log On  Automatically logs on to the last used repository, project, and report 
catalog; if the Save Password check box was not selected, the Log On 
dialog box displays allowing you to select a repository, report catalog, and 
project 

Log On with Options  Opens the Log On dialog box with options allowing you to select a 
repository, report catalog, and project 

Log Off  Logs off the repository  

New Database Alias  Opens the New Database Alias dialog box allowing you to create a 
database alias  

New Ad-hoc Report  Creates an ad-hoc report with the selected cubes in the Ad-hoc Report 
Designer 

New Alea Ad-hoc 
Report  

Creates an Alea ad hoc report 

New Global List  Creates a global list 

Preview  Opens the Preview pane to view a preview of the selected list  

Refresh  Refreshes the view of the OLAP Server database structure to which you 
are connected  

Properties  Displays the properties of an object selected in the Database Structure 
pane 

Database Structure 
Options  

Open the Database Structure Options dialog box  

New Calculation  Creates a calculation; calculations must be enabled in the Database 
Structure pane options  

 

 

By default, the Database Structure pane displays the cubes, dimensions, and hierarchies 
of each OLAP Server database alias. To display additional structural elements, click the 
Database Structure Options button and select the elements to display.  

Report Catalog pane 

The Report Catalog pane allows you to display and administer the different types of reports you create in 
Office Plus, including ad-hoc reports, formula reports, Alea ad-hoc reports, and templates. The buttons in 
the Report Catalog pane vary according to which level of the Report Catalog structure is selected. 

In this pane, you can create a hierarchy of folders in which to organize your reports by right-clicking an 
existing folder and selecting New > Folder.  
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You cannot create a hierarchy of more than eight levels. The default, Global Reports folder 
is at the first level. 

To display the Report Catalog pane, do one of the following: 

 Click the Report Catalog button in the Panes group of the Office Plus toolbar. 

 Click the Report Catalog tab in the left pane. 

Properties pane 

The Properties pane displays the properties of an object selected in the Database Structure pane. To 
open the Properties pane, click the Properties button in the Panes group of the Office Plus toolbar.  

Ad-hoc Report Designer 
The Ad-hoc Report Designer is used to set parameters for ad hoc reports.  

List Designer 
The List Designer pane allows you to define lists for use within reports. From here, you specify which 
elements of a list are shown in the report, how they are sorted, what filters (if any) are applied to them, 
and what attributes (if any) are used. Changes you make in the List Designer affect the display of data in 
a report. Similarly, changes you make in a report affect the structure of the list in the List Designer. 
 

The List Designer includes five panes:  

 Structure Selection  

 Filter  

 Sorting  

 Attributes  

 Advanced 

Preview pane 

The Preview pane displays the elements of a dimension, hierarchy, or list selected in the Database 
Structure pane or of a list selected in an ad hoc report. You can search for elements of the dimension or 
list.  

To open the Preview pane, click the Preview button on the Office Plus toolbar. 
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Check your understanding 

 

 

Which of the following displays the repository you are logged on to and any database 
aliases registered in that repository? 

a) Report Catalog pane 
b) Preview pane  
c) List Designer 
d) Database Structure pane  

 
 
 
 

 

Which section of the Office Plus toolbar opens the Cubes and Data Areas and the 
Dimensions and Subsets dialog boxes? 

a) The Ad-Hoc Report section 
b) The Alea Ad-Hoc Report section 
c) The Database section 
d) The Extras section 
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Lesson 3: Ad hoc reporting 

Estimated time 

2 hours 

Learning objectives 

After completing this lesson, you will be able to: 

 Describe how to create an ad hoc report. 

 Define ad hoc report options. 

 Explain how to use the Ad-hoc Report Designer. 

 Describe navigation in an ad hoc report. 

 Explain how to use the Keep Elements function. 

 Explain how to suppress zero and empty values. 

 List the steps to add a chart to an ad hoc report. 

 Explain how to save an ad hoc report. 

Topics 
 Creating an ad hoc report 

 Navigating in ad hoc reports 

 Adding a chart to an ad hoc report 

 Saving an ad hoc report 
 
  



 

  Infor BI: Creating Reports and Analyzing Data with Office Plus Training Workbook 19 
   © 2015 Infor Education 

Creating an ad hoc report 

An ad hoc report provides a way to view multidimensional data. This type of report uses the Excel 
application as the medium; however, none of the numerical data or formulas, not even Excel formulas, is 
stored in the ad hoc report.  

To create an ad hoc report, do one of the following: 

 Click the New Ad-hoc Report button in the Office Plus section of the toolbar. 

 Double-click a cube in the Database Structure pane, or select the cube and press Enter. 

A default view of the cube will display. By default, the Measure dimension forms the columns in a new ad 
hoc report and the next dimension in the hierarchy forms the rows. The remaining dimensions are used 
as slice-dimensions.  

 

If you are logged on as an Administrator, you can specify a different default view by 
creating an ad hoc report and clicking Save As Default Ad-hoc Report for Cube in the Save 
Ad-hoc Report As dialog box. If there is already a default ad hoc report, you are prompted 
to confirm that you want to overwrite it. This specified default ad hoc report is then the 
default ad hoc report for all users of the cube in the report catalog. 

Ad hoc report options 

The Options dialog box allows you to specify various ad hoc report settings.  

To access the Options dialog box, click the Options button in the Extras section of the toolbar. 

On the Ad-hoc Report tab, you can: 

 Specify representation settings, such as whether or not to display borders or to resize row captions 
automatically. 

 Specify chart settings, such as whether to display only a chart, or a table and a chart, and what 
type of chart to display. 

 Specify slice dimensions settings, such as whether or not to display slice dimensions on the report, 
and if so, whether to display the slice dimensions horizontally. Displaying dimensions horizontally 
can save space; however, column widths may vary based on the length of the element names in 
the slice dimensions and the value range. 
 

On the General tab, you can: 

 Specify language settings. 

 Specify local and template folder file path settings. 

 Specify suppression settings and slice dimension settings, such as whether to display all slice 
dimensions, all hierarchies, or to manually add slice dimensions. 
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Manually add slice dimensions  

If you want to manually add slice dimensions, select Add from the Slice Dimensions drop-down list on the 
General tab of the Options dialog box. When you do, new ad hoc reports will appear with a “Drop lists 
here” area in the header section of the report design area. You can then drag dimensions from the 
Database Structure pane or other areas of the report onto this area. 

 

Manually add slice dimensions 

 

 

 

Demo: Create an ad hoc report 

Your instructor will demonstrate how to set default Office Plus options and create a new 
ad hoc report. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 3.1: Create an ad hoc report 

In this exercise, you will set default Office Plus options and create a new ad hoc report. 

Exercise steps 

1. Click the Options button on the Extras section of the toolbar. The Options dialog box opens. 

2. Click the General tab. 

3. Verify that All dimensions is selected in the Slice-dimensions field. Otherwise, select it. 

4. Click the Report tab, if it is not already displayed.  

5. Select Table in the Display mode drop-down menu. 

6. Select the Show slice-dimensions horizontally check box.    

7. Click Apply.   
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8. Click Yes to confirm that you want to save the property change as a default. This ensures your 
changes will be reflected each time you create a new ad hoc report. 

9. Click OK to close the Options dialog box. 

10. Verify that the Database Structure button is already selected (highlighted) in the Panes section 
of the toolbar, which displays the Database Structure pane. Otherwise, click the button. 

11. Click the plus sign (+) next to Tutor Repository to expand it, if it is not already selected. 

12. Click the plus sign (+) next to Academy to expand it. 

13. Double-click the SALES cube. Sales data displays in the report design area. 

The Ad-hoc Report Designer 

When working with an ad hoc report, the ad hoc report displays in the right pane. The Ad-hoc Report 
Designer consists of the following:  

 Database alias and cube name  

 Slice dimensions 

 Column dimensions  

 Row dimensions  

 Data area 

 

The Database alias and cube name area show the selected database and the selected cube. The 
remaining panes display the slice dimensions, the dimensions used in the rows of the report, and the 
dimensions used in the columns of the report.   

Drag and drop dimensions, hierarchies, and lists between the sections to specify the design of the ad hoc 
report.  

 To exchange two dimensions, drop one dimension on top of the other.  

 To display both dimensions, drop one dimension adjacent to the other. 

 To select a different element from a slice dimension, click the element name in the Slice-
dimensions pane to open the Select Elements dialog box. 

The ad hoc report area 

Two dimensions form an ad hoc report’s columns and rows on the report design area. This is called the 
value range. The other dimensions are above the value range in the header area. They are presented as 
selection lists and marked as slice dimensions.  
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Example ad hoc report 

 

Just as you use the drag and drop method in the Ad-hoc Report Designer, you can use this same method 
to move dimensions between different areas on the actual report.  

 To exchange two dimensions between two areas, drag one dimension to the cell where the name 
of the other dimension is shown and drop it when the cell is framed. 

 To show multiple dimensions in the rows or columns, drag a dimension next to the existing one. 

You can also switch the dimensions shown in the rows and columns of a value range by clicking the 
Transpose Report button in the Ad-hoc Report group of the toolbar. 

 

 

 

Demo: Work with an ad hoc report 

Your instructor will demonstrate how to use the Ad-hoc Report Designer, the Ad-hoc 
Report section of the toolbar, and the Select Elements dialog box to work with an ad hoc 
report. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 3.2: Work with an ad hoc report 

In this exercise, you will use the Ad-hoc Report Designer, the Ad-hoc Report section of the 
toolbar, and the Select Elements dialog box to work with an ad hoc report. 

Exercise steps  

1. Drag the Product dimension in the Slice-dimensions pane of the Ad-hoc Report Designer 
onto the Time dimension in the Rows pane. Release the mouse button when the red line 
displays around the cell. The Product slice-dimension is switched with the Time dimension in the 
value area. 

2. Click the Transpose Report button in the Ad-hoc Report section of the toolbar. This switches 
the dimensions shown in the rows and columns of the value range so that Product is displayed 
across and Version is displayed down. 

3. Click the Sales Volume element below the PROFIT dimension in the header area. The Select 
Elements dialog box opens. 

4. Select the check box to the left of Production Volume. 

5. Click OK. 

6. Click the YTD element below the Time dimension in the header area. The Select Elements 
dialog box opens. 
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7. Clear the YTD element check box. 

8. Click the Multiple Selection button in the toolbar of the Select Elements dialog box (fourth 
button from the right).  

 

By default, slice dimensions show a single element. By enabling multiple selection, you can 
select two or more elements in a slice dimension. The value range will show an 
aggregation of the selected elements. When you enable multiple selection, the header area 
will display every selected element for the slice dimension and the value range will show 
the sum of the selected elements. 

9. Click the plus sign (+) to the left of All Years to expand its contents. 

10. Click the plus sign (+) to the left of 2012 to expand its contents. 

11. Select the check boxes to the left of 2012_Q1 and 2012_Q2. 

12. Click OK. Both selected quarters are displayed below the Time dimension and the values in the 
value range display a summation of the first two quarters, as shown in the screen shot below. If it 
does not, review the previous steps and make the necessary corrections. 
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Navigating in ad hoc reports  

In an ad hoc report, you can vary the data displayed by selecting different slice elements and by 
expanding and collapsing the dimensions that form the columns and rows of the report.  

When a dimension is used to form the columns or rows of a report, its top-level element is displayed. 
Elements with a plus sign (+) can be expanded or drilled-down to reveal further elements.  

 Expanding maintains the hierarchical view of the dimension. As you display elements at lower 
levels, the elements at the higher levels remain visible.  

 Drilling down displays all the elements at the next level down, without displaying the parents.  

Expanding/Collapsing 

Expanding an element that has child elements expands the hierarchy below the selected element to 
display the next level of the hierarchy and its elements. To expand an element, do one of the following: 

 Double-click a parent element in the value range. Parent elements have a plus sign (+) to the left of 
the element name. 

 Right-click the parent element and select Expand or Expand All. Expand All will expand all levels of 
the hierarchy and display their elements, not just the selected one. 

Collapsing an element hides the children of the selected element. To collapse a hierarchy, do one of the 
following: 

 Double-click an expanded element. Expanded elements have a minus sign (-) to the left of the 
element name. 

 Right-click the expanded element and select Collapse. 

Drilling down/Rolling up 

The Drill-down and Roll-up functions are similar to Expand and Collapse but display only the child 
elements, in isolation from their parent and the other elements of the hierarchy. For example, expanding 
an element displays the expanded element and its children within the existing element list; while drilling-
down replaces the element list with the children of the selected element. 

 To drill-down on an element, right-click a consolidated element and select Drill-down. 

 To roll -up, right-click the element list, and select Roll-up. The list will revert to the level above the 
existing element list. 

Resetting a list 

To return a list to its original state, right-click an element and select Reset List. For the Measures 
dimension, this resets the list and displays the default element. For the remaining dimensions, the list is 
reset and displays the root element.  

Using the Keep Elements function 

The Keep Elements function allows you to isolate one part of a hierarchy from the rest of the hierarchy. 
You can then expand, collapse, and drill down within the selected part of the hierarchy, but not in other 
parts of the hierarchy. This is a very useful function to reduce the size of the displayed elements. 

 To keep elements, right-click the parent element of the part you want to isolate and select Keep 
Elements. 

 To return to the whole hierarchy, right-click and select Show Root Level.  
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Demo: Use Expand, Collapse, Drill-Down, and Keep Elements 
functions 

Your instructor will demonstrate how to navigate in an ad hoc report using the Expand, 
Collapse, Drill-Down, and Keep Elements functions, and also reset a list. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 3.3: Use Expand, Collapse, Drill-Down, and Keep Elements 
functions 

In this exercise, you will navigate in an ad hoc report using the Expand, Collapse, Drill-
Down, and Keep Elements functions, and also reset a list. 

Exercise steps 

1. Click the Transpose Report button in the Ad-Hoc Report section of the toolbar. 

2. Double-click All Tires below the PRODUCT dimension. All Tires expands to display its children 
and the icon to the left of the name changes to a minus sign (-) to indicate that it is expanded. 

3. Double-click Winter Tires to display its children. Winter Tires expands to display its children and 
the icon to the left of the name changes to a minus sign (-) to indicate that it is expanded 

4. Double-click Winter Tires again. The hierarchy collapses and the icon to the left of Winter Tires 
changes to a plus sign (+) to indicate that it can be expanded. 

5. Right-click Summer Tires.  

6. Select Drill-down from the shortcut menu. Instead of expanding, only the children of Summer 
Tires display. Note: Subsequent steps will combine the right-click action with the selection of the 
shortcut menu option. 

7. Right-click <any of the elements> in the row headers and select Roll-up. 

8. Right-click <any of the elements> in the row headers and select Reset List. 

9. Right-click All Tires and select Expand All. 

10. Hold down the Ctrl key and select <any three elements>. 

11. Right-click and select Keep Element. The report displays only the elements from which the 
selected values are derived. 

12. Right-click <any of the elements> displayed and select Reset List to return the list to the 
original selection. 

 

Resetting the list will return the list to its original state, not the configuration it was in 
immediately before you used the Keep Element function. 
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Displaying top or bottom values 

You can sort data to display only the top or bottom values, for example, show the top revenue products. 
You can specify whether to limit the values to a specific number of elements (5, 10, 25, 50, or 100), or a 
specific percentage of elements. 

To show top or bottom values, right-click a value in a column to sort and select Only Show Top Values or 
Only Show Bottom Values. Then, select a value or percentage from the shortcut menu. A white triangle in 
the column indicates that the data is sorted. To show all elements again, right-click the column and select 
Only Show Top/Bottom Values > Show All.  

When you display top or bottom values, the Sorting pane of the List Designer is enabled. In the Sorting 
pane, you can see how the sort is defined. The definition changes as you select different top or bottom 
values. Changes that you make to the definition in the Sorting pane are reflected in the report. 

Suppressing empty and zero cell values 

A common feature of multidimensional databases is that for many combinations of rows and columns, 
there is no data. Reports can include a large number of empty cells (represented by default as #N/A) or 
zero values. In an ad hoc report, you can exclude columns and rows that contain only zero values or 
columns and rows that do not contain any values (empty).  

When you suppress zero values, any column or row that contains only zero values is hidden. If the 
column or row contains at least one non-zero value, the zero values in that column/row will still displayed. 
You can automatically suppress values to ensure they are never displayed in a report or manually 
suppress them when they are displayed.  

Automatic suppression 

To automatically prevent zero values from being displayed, click Options in the toolbar and go to the 
General tab. There you can specify the mode of suppression as the default for new ad hoc reports.   

Manual suppression  

To manually suppress zero and empty values, do one of the following: 

 Right-click the data area of the report and select Suppress Empty and Zero Rows and Columns or 
Suppress Empty Rows and Columns. Note: Suppressing empty and zero rows and columns will 
suppress both empty and zero values. Suppressing empty rows and columns will only suppress 
empty values, but not zero values. 

Click the Suppression button in the Ad-hoc Report section of the toolbar and select the appropriate option 
from the drop-down menu that displays. 

 

 

Demo: Suppress empty and zero cell values and display top elements 

Your instructor will demonstrate how to manually suppress zero and empty cell values and 
display the top five elements. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 



 

  Infor BI: Creating Reports and Analyzing Data with Office Plus Training Workbook 27 
   © 2015 Infor Education 

 

 

 

Exercise 3.4: Suppress empty and zero cell values and display top 
elements 

In this exercise, you will manually suppress zero and empty cell values and display the top 
five elements. 

Exercise steps 

1. Double-click the All Tires row header to expand it.  

2. Right-click the All Tires row header and select Suppress Zero and Empty Rows. All rows that 
display Not Analysed and Dummy are removed. 

3. Right-click the All Tires row header and select No Suppression on Rows. 

4. Right-click the All Tires row header and select Only Show Top Values > 5. 

5. Right-click the All Tires row header and select Only Show Top Values > Show All to return to the 
original list. Your screen should look like the screen shot below. If it does not, review the previous 
steps and make the necessary corrections. 
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Adding a chart to an ad hoc report 

The Presentation button in the Ad-hoc Report section of the toolbar can be used to add a chart to an ad 
hoc report. You can drill down, roll up, collapse and expand the data series of a chart in the same way as   
in the table. The data in a table expands and collapses with the data in a chart. 

 

 

Demo: Add a chart to an ad hoc report 

Your instructor will demonstrate how to add a chart to an ad hoc report. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 3.5: Add a chart to an ad hoc report 

In this exercise, you will add a chart to the ad hoc report. 

Exercise steps 

1. Click Presentation on the toolbar.  

2. Select Table and Chart from the drop-down menu. A bar chart displays below the table and the 
Chart Type toolbar button becomes activated. 

3. Click the Chart Type toolbar button.  

4. Select Column from the drop-down menu. The bar chart changes to a chart displaying columns. 
Your screen should look like the screen shot below. If it does not, review the previous steps and 
make the necessary corrections. 
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5. Select Presentation > Table. This removes the chart and returns the report to a table-only view. 
Note: If you do not perform this step, several upcoming exercises will not work properly.  
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Saving an ad hoc report 

You can choose to save a report as a global report in the repository on the server or you can save it as a 
local report on your local computer. Ad hoc reports are saved as .XLSX files; they can be stored in, and 
opened from, any disk location. 

 

You can specify the default location for saving local reports on the General tab of the 
Options dialog box. 

 

Demo: Save an ad hoc report 

Your instructor will demonstrate how to save an ad hoc report. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 3.6: Save an ad hoc report 

In this exercise, you will save the ad hoc report and then reopen the report to ensure it has 
been saved. 

Exercise steps 

1. Click the Save button in the Office Plus section of the toolbar. The Save Ad-hoc Report As 
dialog box opens. 

2. Verify the Global Reports folder is selected in the Report location pane. Otherwise, select it. 

3. Click the Create a new folder in the current location toolbar button of the Save Ad-hoc Report 
As dialog box. A new folder displays. 

4. Type Office Plus Basic Training <your initials> as the name of the folder.  

5. Press Enter. 

6. Double-click the Office Plus Basic Training <your initials> folder to open it. 

7. Type <your initials> Ex 3.6 Report in the Report name field. 

8. Click Save. 

9. Select File > Close to close the report. 

10. Click Report Catalog in the Panes group to display the Report Catalog pane. 

11. Expand the Global Reports > Office Plus Basic Training <your initials> folders. 

12. Double-click your saved <your initials> Ex 3.6 Report ad hoc report to open it. 

13. Close the ad hoc report. 
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Scenario: Create an ad hoc report 

In this scenario, you will practice creating an ad hoc report. This scenario does not include 
detailed steps so that you have the opportunity to apply the knowledge and skills you have 
learned in this Lesson.  

For this scenario: 

 Use the Sales cube to create a new ad hoc report with the following specifications: 

Row dimension  Unit 

Column dimensions  

 

 VERSION 

 CURRTYPE 

Slice dimension 
selections 

 Year 

 2012 

 Products 

 All Season Tires 

 Summer Tires 

 Winter Tires 

 Profit 

 Gross Margin 

 

 Drill-down to the base level of the rows. 

 Suppress the null and zero values at the row level. 

 Sort by local currency in descending order. 

 Add a column chart below the table. Your screen should look like the screen shot below. If it does 
not, review the information above or the appropriate steps in previous exercises and make the 
necessary corrections. 

 

 Save the report as <your initials> L3 Scenario Report in your Office Plus Basic Training 
folder within the Global Reports folder.   
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Check your understanding 

 

 

 

You can specify representation settings, chart settings, and slice dimension settings on 
which tab of the Options dialog box in Infor BI Office Plus? 

a) Ad-hoc Report  
b) Captions and Error Values 
c) Calculation 
d) General  

 
 
 
 

 

The Ad-hoc Report Designer in Office Plus consists of which of the following? Select all 
that apply. 

a) Slice-dimensions 
b) Column dimensions 
c) Row dimensions  
d) Cube name 

 
 
 

 

In Infor BI Office Plus, expanding an element that has child elements expands the 
hierarchy below the selected element to display the next level of the hierarchy and its 
elements. 

 

a) True 
b) False 
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Lesson 4: Using the List Designer 

Estimated time 

1 hour 

Learning objectives 

After completing this lesson, you will be able to: 

 Describe the functionality of the List Designer. 

 Identify the List Designer panes. 

 Explain how to select elements to display in a list. 

 Explain how to filter data within a list. 

 Explain how to sort data within a list. 

 List the steps to display attributes for a dimension. 

 Describe the options in the Advanced pane. 

Topics 
 List Designer overview 

 The Structure Selection pane 

 The Filters pane 

 The Sorting pane 

 The Attributes pane  

 The Advanced pane 
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List Designer overview 

Lists include the elements that you use in ad hoc reports. The List Designer is used to specify which 
elements of a hierarchy are shown in a report, through the use of structure selection, filters, sorting, 
attributes, and other advanced features. Changes you make in the List Designer affect the display of data 
in a report. Similarly, changes you make in a report affect the structure of the list in the List Designer.  

To display the List Designer, do one of the following: 

 Click the List Designer button in the Panes section of the toolbar. 

 Click a dimension cell.  

 

Lists can become invalid if the cube to which they are assigned is deleted. 

 

List Designer panes 

The List Designer includes the following five panes:  

 Structure Selection  

 Filter  

 Sorting  

 Attributes  

 Advanced 
 

 
List Designer panes 
 

 To open a pane, click its title.  

 To close a pane, click the double-arrow icon. 

 To disable a filter, a sort, or an attribute selection without deleting the definition, clear the Enabled 
check box. 

 

List Designer toolbar 

The List Designer includes four toolbar buttons that can be used with each of the individual panes. The 
following table identifies the toolbar buttons and provides a brief description of each: 
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Toolbar button Description 

Apply changes to the list Updates the list in the actual report with any changes made in the List 
Designer. 

Discard list changes Discards any changes made in the List Designer. 

Preview  Allows you to preview the results of your changes before saving them.  

Help  Displays Office Plus Help topics about the List Designer.  

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
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The Structure Selection pane 

The Structure Selection pane of the List Designer allows you to specify which elements of a hierarchy are 
displayed in an ad hoc report. Elements can be selected individually or by reference to their position in a 
hierarchy. Similarly, changes to the element selection in a report (by expanding, collapsing, drilldown, or 
keep elements) are reflected in the Structure Selection pane of the List Designer.   

In the Structure Selection pane of the List Designer, each element and level of a selected hierarchy 
includes a check box. To select individual elements or hierarchy levels, select their check boxes in the 
Structure Selection pane of the List Designer. You then apply the changes to view the updates to the list. 

Structure Selection pane toolbar  

You can use the Structure Selection pane toolbar buttons to select elements. The following table 
identifies the toolbar buttons on the Structure Selection pane and provides a brief description of each: 

Toolbar button Description 

Suppress Empty 
Elements 

This button suppresses empty elements. This feature does not actually 
remove empty elements from a report; rather, it allows you to identify, and 
exclude from the list, elements that do not have associated data. 

 Clicking this button displays only those elements that are associated 
with data. 

 Unclicking this button displays all the elements of the list, including ones 
without values.  

Note: When an element selected in the List Designer refers to an empty 
cell, #NA is displayed in the report. 

Select Children Selects elements under a common parent 

Select Parent  Selects elements above a selected element 

Select Siblings  Selects elements at the same level with a common parent 

Function (fx)  

 Range This feature selects elements from one point in the hierarchy to another 
point and include all the items in between, which are on the same level. 
For example, selecting the range FROM 2009 TO 2013 displays 2009, 
2010, 2011, 2012, and 2013 in the report. 

 Elements 
Underneath 

 

 All, Including 
Parent 

This feature selects all elements under a selected element, including the 
element itself.  

 All, Excluding 
Parent 

This feature selects all elements under a selected element, but not the 
element itself. 

 All Base 
Elements 

This feature selects all elements that do not have children - ones that do 
not have elements underneath them in the hierarchy.  

 Descendants This feature allows you to select a specific level of the list as the parent 
and returns the descendants. 

 Periods to Date This feature selects all elements within the same level, up to, and 
including, the selected element, related to a parent. As the name 
suggests, the Periods to Date function is intended for use with time-based 
lists.  
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Toolbar button Description 

 Previous Periods This feature allows you to select an element and specify how many 
elements before it you want to return. For example, if you select May, and 
specify 3 as the index, March and April are returned. 

Select Level This feature selects all elements on a hierarchy level, based on your 
selection. For example, you can select all tire product groups or all tire 
sizes. 

In this example, level refers to level-based hierarchies (top down) and not 
to aggregation levels (bottom up). 

Select Set This feature selects all elements based on the selected set. 

Find Element Opens the Find Element dialog box allowing you to search for a specific 
element 

Remove Deletes the selection criteria 

Up and Down Moves the selection criteria up or down 

Note: You can also right-click an element to display a drop-down menu with the same structure selection 
options as the toolbar button. 

As you navigate in the ad hoc report, selections automatically appear in the lower part of the Structure 
Selection pane. Therefore, when applying structure selection changes, the existing selections may need 
to be deleted.  

Using the Whole hierarchy check box in the Structure Selection pane, allows you to ignore your existing 
selections and use the whole hierarchy in the list instead. This feature can be useful when you have 
created a complex selection of elements and want to disable it temporarily, without deleting your 
selections. Infor does not recommend using the Whole hierarchy check box on very large dimensions.  

 

 

Demo: Use the Structure Selection pane to select elements 

Your instructor will demonstrate how to use the Structure Selection pane to select 
elements. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 4.1: Use the Structure Selection pane to select elements 

In this exercise, you will use the Structure Selection pane to select elements. 

Exercise steps 
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1. Open the saved <your initials> Ex 3.6 Report ad hoc report. 

2. Double-click All Tires below the PRODUCT dimension header to collapse the hierarchy. 

3. Click the PRODUCT dimension header to display the PRODUCT dimension in the Structure 
Selection pane of the List Designer. 

4. Click the List Designer button in the Panes group of the toolbar, if the List Designer is not 
visible. 

5. Click the Level:All element in the pane in the bottom half of the Structure Selection pane.  

6. Click the Delete toolbar button to delete the Level:All element.  

7. Click All Tires in the Structure Selection pane of the List Designer. Note: Click the All Tires 
text, but do not select the check box. 

8. Click the Select Children button in the toolbar of the Structure Selection pane. All Tires 
displays below Element in the Selection Settings area of the Structure Selection pane. 

9. Click the Apply changes to the list toolbar button in the List Designer. The six children of All 
Tires display in the PRODUCT dimension.  

10. Expand Winter Tires in the Structure Selection pane. 

11. Select W7000 Icetrack in the Structure Selection pane. 

12. Click the Select Siblings toolbar button.  

13. Click the Apply changes to the list toolbar button. The six children of All Tires and the children 
of Winter Tires are displayed.  

14. Select <each element> individually in the bottom half of the Structure Selection pane.  

15. Click the Delete toolbar button to delete each selected element from the pane. 

16. Select All Tires in the Structure Selection pane. 

17. Click the fx (Functions) button.  

18. Select Elements underneath All Tires (base elements).  

19. Click the Apply changes to the list toolbar button. Only the base elements appear in the value 
range. 

20. Select Elements underneath All Tires (base elements) in the bottom half of the Structure 
Selection pane.  

21. Click the Delete button to remove the selection. 

22. Select Van Tires in the Structure Selection pane. 

23. Click the fx button.  

24. Select Descendants.  

25. Select Tire from the Level field drop-down menu in the Selection Settings pane. 

26. Leave Flag set to Self.  

27. Click the Apply changes to the list toolbar button. Notice the elements that display in the value 
range. These settings cause C2001 Citycruiser, C2002 Citynet, and C3000 Loader to display. 
Below Van Tires, these elements are at Level 3. Because the flag is set to Self, only those three 
elements display. Your screen should look like the screen shot that follows. If it does not, review 
the previous steps and make the necessary corrections. 
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28. Save the report as <your initials> Ex 4.1 Ad Hoc Report in your Office Plus Basic Training 
folder within the Global Reports folder. 

29. Close the ad hoc report. 
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The Filter pane 

Use filters to determine whether or not to include specific elements in a report. You can include or 
exclude elements with a caption, unique name, attribute, or value that matches criteria you specify. You 
can also enter an MDX statement to define a filter.  

To open the Filter pane, click its heading in the List Designer.  

Filter pane toolbar 

You can use the Filter pane toolbar buttons to filter elements. The following table identifies the toolbar 
buttons on the Filter pane and provides a brief description of each: 

Toolbar button Description 

New Filter Create a new filter. 

New AND operation Add an AND operation to the filter. 

New OR operation Add an OR operation to the filter. 

New NOT operation Add a NOT operation to the filter 

Operator Change a logical operator, for example, from AND to OR 

Remove Deletes the filter definition.  

Up and Down Moves the selected filter criteria up or down. 

Note: You can also right-click a filter in the Filter pane to display a drop-down menu with the same 
options as the toolbar button. 

Filters can be combined using the operators AND, OR, NOT so that a report displays, for example, values 
between “x” and “y,” and not less than “z.”  

 

The Enabled check box in the Filter and pane enables or disables all filters. You can also 
manually enable or disable filters by selecting the filter and then selecting False from the 
Enabled list in the Filter Settings. 

Filter by 
You can filter elements by: 

 Caption 

 Unique name 

 Attribute 

 Value  

 Custom MDX 
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The following table identifies methods for filtering data and provides a brief description of each method: 

Filter Method Description 

Caption This method filters elements by caption. For example, you can filter 
elements that begin with “W” in the Product Dimension. 

Unique name This method filters elements by the unique names that were 
generated by the database, or by the name of the element displayed 
in the report. Use the text filter to search for texts and strings. 

Attribute  Filters by attribute values 

Value  Filters by values 

Note: You will filter automatically by the values you see in the current 
slice of the ad hoc report. If you want to filter the row elements, and 
you see several columns, then you need to indicate which column’s 
values you want to filter.  

Custom defined MDX  Creates a filter using an MDX statement 

Filter type 

When you filter by caption, unique name, or attribute, you select one of the following filter type options. 
The choices available depend on the selected filter type:  

 String 

 Wildcard 

 Regular Expression 

 Number 
 

The following table identifies the filter types and provides a brief description of each method: 

Filter type Description 

String  Filters for elements identical to the complete value entered.  

Wildcard  This type filters using wildcards. You can use the question mark (?) to replace single 
characters and the asterisk (*) to replace parts of strings.  

Regular 
Expression  

Filters by regular expressions 

 

Office Plus Help 
Filters 

 

Number Filters by numerical value entered 
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Condition 

The following table identifies the filter condition operators and provides a brief description of each: 

Condition Description 

*  This condition indicates that there is no restriction: no condition is set 
(default setting). The input box is disabled.  

=  The entered value will be considered.  

>=  Values greater than the entered value and the value itself will be 
considered.  

<=  Values smaller than the entered value and the value itself will be 
considered.  

>  Values greater than the entered value will be considered.  

<  Values smaller than the entered value will be considered.  

<>  Values greater and smaller than the entered value will be considered.  

Contains  Strings or numbers containing the entered value will be considered.  

Does not contain  Strings or numbers which do not contain the entered value will be 
considered.  

 

 

 

 

Demo: Filter by Value 

Your instructor will demonstrate how to use the Filter pane to filter elements by Value. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 4.2: Filter by Value 

In this exercise, you will use the Filter pane to create a filter that displays Unit dimension 
elements with values above 500,000. 

Exercise steps 

1. Open the <your initials> Ex 3.6 Report. 

2. Swap the UNIT slice-dimension with the PRODUCT row. 

3. Expand all elements of the UNIT dimension. 
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4. Select the Filter pane in the List Designer. 

5. Click the New Filter button. A Filter Settings area displays within the Filter pane. 

6. Specify the following criteria in the Filter Settings area: 

 Set the Filter By field to Value. 

 Set the Condition to Equal or greater than. 

 Set the Value to 500000. 

7. Click the Fill button to specify the values in the Data Area. You will leave the default Data Area, 
which matches the data slice shown on the report.  

8. Click Apply changes to the list in the toolbar of the List Designer. The value range displays 
only those elements whose values are equal to or greater than 500,000. Your screen should look 
like the screen shot below. If it does not, review the previous steps and make the necessary 
corrections.  
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The Sorting pane 

Sorting arranges the elements of a list. The sorting with cut-off criteria can influence the number of 
elements displayed in the report. 

Sorting pane toolbar 

You can use the Sorting pane toolbar buttons to sort elements. The following table identifies the toolbar 
buttons on the Sorting pane and provides a brief description of each: 

Toolbar button Description 

New Sorting Criterion Creates a sorting criterion 

Break Hierarchy With this non-hierarchical ordering, the elements are arranged without 
reference to their position in the hierarchy. In an unbroken hierarchy, 
elements are first ordered by their position in the hierarchy and then 
ordered within each level. 

Remove Deletes the sorting definition  

Up and Down Moves the selected sorting criteria up or down 

  

 

The Enabled check box in the Sorting pane enables or disables all sorts. You can also 
manually enable or disable a single sorting criterion by selecting it and then selecting False 
from the Enabled list in the Sorting Criteria Settings.  

Sorting by 

You can sort data by the following: 

 Caption 

 Unique name 

 Attribute 

 Value  

 Custom MDX 

 

The following table identifies sorting types and provides a brief description of each: 

Sorting Types Description 

Caption  Sorts elements by their captions  

Unique name  Sorts elements by their unique names  

Attribute  Sorts elements by their attributes  
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Sorting Types Description 

Value This type sorts the elements by value. When you sort by value, you must 
define the cut-off type, cut-off value, and the Dataspace.  

For example, you can sort by value with a cut-off type of Top Count. The 
cut-off value you enter should specify how many top elements should 
display. For example, you can specify that the top 5 products display. If 
you select None as the cut-off type, the list elements are sorted in 
ascending or descending order.  

Custom MDX  Sorts elements defined in an MDX statement 

Sorting order 

You can sort data in ascending or descending order. 

 

 

 

Demo: Sort by Caption 

Your instructor will demonstrate how to use the Sorting pane to sort elements by caption 
in ascending order. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 4.3: Sort by Caption 

In this exercise, you will use the Sorting pane to sort elements by caption in ascending 
order. 

Exercise steps 

1. Select False from the Enabled drop-down menu in the Filter Settings area to disable the filter 
you applied to the UNIT dimension in the previous exercise. 

2. Expand all elements of the UNIT dimension. 

3. Select the Sorting pane in the List Designer. 

4. Click the New Sorting Criterion button. 

5. Select Caption from the Type drop-down menu in the Sorting Criterion Settings area, if it is not 
already selected. 

6. Select Ascending from the Order drop-down menu, if it is not already selected. 

7. Click Apply changes to the list in the toolbar of the List Designer. The sorting criteria is applied 
to the list. Notice the elements in the value range are still not listed alphabetically. This is because 
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the elements under European Holding are sorted alphabetically, but other elements have 
different parents than European Holding. Therefore, they are sorted separately. 

8. Click the Break Hierarchy button in the Sorting pane toolbar to sort all four elements as a group. 

9. Click Apply changes to the list. All elements are sorted as a group. The Break Hierarchy 
feature treats all of the elements equally, regardless of whether they have the same parent.  

10. Save the report as <your initials> Ex 4.3 Report in your Office Plus Basic Training folder 
within the Global Reports folder.  
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The Attributes pane 

Elements are often assigned different attributes, which can also be used in reports. Attributes are stored 
in the OLAP Server database and can be used to add further information to a list. For example, you can 
assign the name of a product manager as an attribute to the Products dimension, so you can easily see 
who is responsible for which products. These assignments are made using attribute tables. 

 

Attribute tables 

 

To display the attributes of an element, select them in the Attributes pane of the List Designer. In the list 
of attributes, select the check box for each attribute you want to be displayed. You can change the order 
of the attributes with the Up and Down toolbar buttons 

 

 
You can also choose to display attributes in place of element names. 
 
To show attributes only: 

1. Open the Options dialog and go to the Captions and Error Values tab. 

2. Choose Attributes from the Caption style drop-down menu. 

 

Attributes pane toolbar 

The following table identifies the toolbar buttons on the Attributes pane that are available in Office Plus. 

Toolbar button Description 

Up and Down Moves the selected attribute up or down 
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Demo: Include attributes 

Your instructor will demonstrate how to use the Attributes pane to include attributes on a 
report. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 4.4: Include attributes 

In this exercise, you will use the Attributes pane to include attributes on a report.  

Note: Refer to previous exercises for assistance if you are unsure how to perform certain 
steps. 

Exercise steps 

1. Remove the Sorting Criterion you applied to the UNIT dimension in the previous exercise. 

2. Swap the PRODUCT slice dimension with the UNIT row. 

3. Select PRODUCT. 

4. Select the Attributes pane in the List Designer. 

5. Select the ID attribute check box. 

6. Click Apply changes to the list in the toolbar of the List Designer. The ID attribute displays 
next to PRODUCT in the value range. 

7. Save the report as <your initials> Ex 4.4 Report in your Office Plus Basic Training folder 
within the Global Reports folder. 

 

Notice that the Enabled check box is selected in the Attributes pane. Clearing this check 
box will no longer display the attribute in the value range. However, because the ID 
attribute is still selected in the Attributes pane, you can easily re-display it by selecting the 
Enabled check box again. 
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The Advanced pane 

The following table identifies the sections available on the Advanced pane and provides a brief 
description of each: 

Toolbar button Description 

General Displays the data source of the list (database alias, cube, dimension and 
hierarchy).  

Hierarchy Allows you to specify: 

 If elements that exist several times in a list are displayed only once 
(DISTINCT = TRUE). 

 If the hierarchy displays by levels 
(HIERARCHIZED = TRUE).   

 If the hierarchy should be inverted 
(INVERT HIERARCHY = TRUE). 
Use this to get totals at the end of every level  

 “Secure structure when drilling down”: not applicable (Application Studio 
only).   

List Allows you to specify whether a list is cacheable, displays its version, and 
provides a description. 

MDX Allows advanced users to create customized structural filters, text filters, and 
sorts using MDX statements. These can be used or combined with the List 
Designer functionality. For example, you can use structure selection in the 
List Designer to structure a list, and use an MDX statement to sort a list.  

Subset When this function is set to True, the following parameters are enabled:  

 Count  

 Base Element  

 Start 

You can define a subset to control which elements of a local list are displayed 
using these parameters. You define the number of elements to be displayed 
in the subset (Count). You then specify the point in the hierarchy where the 
subset should start (Start) in relation to an element you select (Base 
Element). The start point can be the same as the base element or it can be a 
number of elements below it.  

 

 

 

Demo: Use Hierarchy and Subset functions 

Your instructor will demonstrate how to use the Hierarchy pane to display elements. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
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Exercise 4.5: Use Hierarchy Functions 

In this exercise, you will use the Advanced pane to display hierarchies in different ways. 

Exercise steps 

1. Create a new ad hoc report for the SALES cube. Refer to exercise 3.1 for assistance if you are 
unsure how to create a new ad hoc report. 

2. Expand All Tires. 

3. Set Invert Hierarchy to True for the PRODUCT dimension in the Advanced pane.  

4. Click Apply changes to the list in the toolbar of the List Designer. The All Tires element will be 
displayed at the bottom in the list. 

5. Set Hierarchized to False in the Advanced pane.  

6. Click Apply changes to the list in the toolbar of the List Designer. The plus and minus signs 
will disappear and all elements will be displayed left-aligned. 

7. Close the report without saving. 
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Check your understanding 

 

 

Which Infor BI Office Plus function allows you to isolate one part of a hierarchy from the 
rest of the hierarchy? 

a) Expand/Collapse 
b) Keep Elements 
c) Reset List 
d) Only Show Top Values  

 
 
 
 

 

In Office Plus, how are empty cells represented by default? 

a) Error  
b) #N/A 
c) 0 
d) Empty  

 
 
 

 

Structure Selection, Filter, Sorting, Attributes, and Advanced are all areas in which 
component of the Infor BI Office Plus user interface? 

a) The Database Structure pane 
b) The List Designer 
c) The Office Plus toolbar 
d) The Ad-hoc Report Designer  
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Lesson 5: Data entry 

Estimated time 

1 hour 

Learning objectives 

After completing this lesson, you will be able to: 

 Explain how write back works. 

 Identify the different write back methods. 

 Describe allocation and alteration. 

Topics 
 Writing back values 

 Using the Write Back dialog box 

 Write back commands 

 Reallocation 

 Immediate and non-immediate write back 
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Writing back values 

In a multidimensional cube, all data is stored in base cells. Therefore, by editing these cells, you can write 
back values to these base cells. You also can write back values to aggregated data cells using Office 
Plus. The values will then be distributed to all underlying base cells. This ensures consistency of the 
entire cube at all times. 

 

No particular settings are needed to write to the cube. However, the user has to have the 
appropriate rights to write to the database. 
 

 

 

Demo: Write back values to base cells 

Your instructor will demonstrate how to how to write back values to base cells. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 5.1: Write back values to base cells 

In this exercise, you will write back values to base cells. 

Exercise steps 

1. Open a new ad hoc report for the SALES cube. Refer to previous exercises for assistance if you 
are unsure how to open a new report. 

2. Configure the report using the following criteria: 

Dimension Location or Element 

PRODUCT  Rows in value grid (Expand all) 

YEARS Columns in value grid 2014, Jan. 2014, Feb.2014…. (All months) 

CURRTYPE Local Currency 

UNIT Genesis Germany GmbH 

PROFIT Sales Volume 

VERSION Forecast 

3. Enter the following values for Tires in Jan 2014 and Feb 2014:           

 AS600/175: Jan 2014: 100 Feb 2014:  200  

 AS600/185: Jan 2014: 200 Feb 2014:  400 
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4. Press Enter. The values are aggregated in the Product dimension to “AS600 Aquachrono”, “All 
Season Tires”, and “All Tires”. In the Time dimension they are aggregated to Year 2014.   
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Using the Write Back dialog box 

If a value is entered in an aggregated cell, a Write Back dialog box will open, similar to the one shown 
below: 

 

Write Back dialog box 

Write-back Method field 

The following table identifies the write-back methods that can be used in the Write Back dialog box, along 
with the result and a brief example for each method. 

Write-back method Result Example 

Weighted Distribution The proportions of child 
values to each other are 
maintained when the value of 
their parent is increased or 
decreased. 

 

The value of the parent cell is 6 and the 
value of each of its three children is 1, 2 
and 3. You write 12 to the parent cell and 
choose “New Value.” The value of each 
child cell will be doubled. So, the value of 
the three children will be 2, 4, and 6.  
 

Equal Distribution Values entered in parent cells 
are distributed equally to their 
children. 

A parent cell has three children. You write 
12 to the parent cell and choose “New 
Value.” The value of each child cell 
becomes 4.  
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Write-back method Result Example 

To each leaf A value that you write to a 
parent cell is written to each 
child cell. The value of the 
parent cell changes 
accordingly.  

A parent cell has three children. You write 
2 to the parent cell. The value of each child 
cell becomes 2. The value of the parent cell 
becomes 6. 

LIKE You can splash* values to the 
children of a consolidated cell 
in the same proportions as the 
values of the children of 
another consolidated cell. 

 

*Splashing refers to the 
distribution of values 
according to a variety of rules. 
See lesson 7 for more 
information. 

The first quarter sales figures in 2005 are 
60. The figures for the individual months 
are October 10, November 20, and 
December 30. 

You enter 120 in the second quarter, 
choose “New Value” and select the first 
quarter as the element to refer to in the 
Source Cells Area of the Write Back dialog 
box. The figures for the second quarter will 
be October 20, November 40, and 
December 60. 

COPY You can copy values from one 
area of a cube to another, 
such as the actual figures for 
one year to the budget for 
another year. Values that you 
copy from one area of a cube 
to another replace existing 
values. 

The first quarter sales figures in 2005 are 
60. The figures for the individual months 
are October 10, November 20, and 
December 30. 

You enter #C in the second quarter, 
choose “New Value” and select the first 
quarter as the element to refer to in the 
Source Cells Area of the Write Back dialog 
box. The figures for each month in the 
second quarter will be the same as in the 
first quarter. 

COPYFULL The COPYFULL command 
works in the same way as 
COPY, but it also copies 
values that are calculated by 
rules. 

 

 
New Value section 

The new value can be achieved by adding an absolute value, adding a percentage, or setting a new 
absolute value. Note: When you use the Value and New Value options in this section, it is the same as 
using the allocate (#) and alter ($) commands discussed in the Write back commands topic. 

 
Source Cells section 

Some write back methods (e.g. Weighted reallocation, Equal reallocation, LIKE, and COPY) require the 
definition of related hierarchies and elements. 
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Write back commands 

Instead of using the Write Back dialog box, you have the option of typing commands into cells to initiate 
the spreading. This allows you to skip the Write Back dialog box and can save time. 

 

The following table provides the methods and codes that can be used to initiate the spreading. 

Method Code  

Weighted W 

Equal E 

Base (to each leaf) B 

COPY C 

LIKE L 

(Allocate Value) # 

(Alter Value) & 

Each write back method supports two or three syntaxes. For example, #W[value] and #@[value] are 
equivalent. 

For each write back method, you must specify either allocation (#) or alteration (&) of values, as follows: 

 Allocate replaces existing values 
o Example: If a cell contains a value of 1 and you write 2 using allocate, then the cell value 

becomes 2. 

 Alter amends existing values by value entered 
o Example: If a cell contains a value of 1 and you write 2 using alter, then the cell value 

becomes 3. 

Additive and subtractive syntax 

By default, write back methods are additive; they increase existing values in a variety of ways. However, 
the default syntax of each write back method can be amended to subtract values and to specify values by 
a percentage.  

Examples using additive and subtractive values 

Syntax example Explanation  

&W20  Adds 20 to the cell value  

&W-20  Subtracts 20 from the cell value  

&W5%  Increases the cell value by 5%  

 

The plus (+) sign is implied and does not need to be entered; however, you can enter it. 
For example &W+20. 
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Spreading syntax 

Spreading syntax allocates values written to aggregated cells to base cells. The method of allocation 
depends on the following situations:  

 If the base cells contain values, the ratio of each value to the value of the aggregated cell is 
calculated. Values written to the aggregated cell are allocated to the base cells in the same ratios. 

 If the cells are empty, the amount written to the aggregated cell is allocated equally between the 
base cells.  

 If the base cells contain values and one or more base cells is locked, the ratio of each unlocked 
value to the value of the aggregated cell is calculated. The value of the locked cell is subtracted 
from the amount to be allocated. The remainder is allocated to the unlocked cells in the ratios 
calculated.  

 If the cells are empty and one or more base cells is locked, the amount written to the aggregated 
cell is allocated equally to the unlocked base cells. 

 
The following table displays the write-back syntax supported by the Infor OLAP server. 

Method Reallocation = No Reallocation = Yes 

Allocate 
 

Alter Allocate Alter 

Weighted #W[value] 
 

&W[value] #W[value]?[set] &W[value]?[set] 

Equal #E[value] 
 

Not supported #E[value]?[set] Not supported 

Base  #B[value] 
 

Not supported   

COPY #COPY[tuple] 
#C[tuple] 
 

Not supported   

LIKE #LIKE[tuple] 
#L[tuple] 
 

Not supported   

 

 
Example using a tuple 
 
You want to copy the fourth quarter budget for 2008 to the actual results for the same quarter. Select the 
cell containing the actual figures for the quarter and specify:  

#COPY [VERSION].[Budget];[TIME].[All Years].[2008].[Q4_2008]  
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Demo: Write back to aggregated cells  

Your instructor will demonstrate how to write back to aggregated cells using the Equal 
Distribution and Weighted Distribution methods. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 5.2: Write back to aggregated cells  

In this exercise, you will write back to aggregated cells using the Equal Distribution and 
Weighted Distribution methods. 

Exercise steps 

1. Open the <your initials> Ex 3.6 Report. 

2. Add the Forecast element to the VERSION dimension.  

3. Select GENESIS UK INC in the UNIT dimension.  

4. Select January 2012 in the TIME dimension.  

5. Select the whole hierarchy check box in the PRODUCT dimension in the List Designer. 

6. Click Apply changes to the List. 

7. Type 800 in the Forecast field for All Season Tires. 

8. Press Enter. The Write Back dialog box opens with 800 in the New Value field. 

9. Select Equal distribution from the Method field.  

10. Click OK. The value is distributed equally to all base elements of All Season Tires. 

11. Type the values 0, 0, 2, 1, 2, 1, 2, 1 into the Forecast field of the base elements of Winter Tires. 
These are not the actual values for the products, but will be used to weight the distribution. 

12. Type 8100 into the Forecast field for Winter Tires. 

13. Press Enter. The Write Back dialog box opens. 

14. Select Weighted distribution from the Method field.  

15. Click OK. The value is distributed among the base elements of Winter Tires in the proportion 
determined by the values you entered (0, 0, 2, 1, 2, 1, 2, 1,). 

16. Type 5400 into the Forecast field for Summer Tires. 

17. Press Enter. The Write Back dialog box opens. 

18. Select LIKE from the Method field. 
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19. Select VERSION from the Hierarchy drop-down in the Source Cells area of the Write Back 
dialog box.  

20. Click the Element button that displays next to the VERSION Hierarchy in the Source Cells area. 

21. Select Actual as the element for the VERSION Hierarchy field. 

22. Click OK. The value 5400 is distributed among the children of Summer Tires based on the 
proportion determined by the same elements in the actual field. 

23. Save the report as <your initials> Ex 5.2 Report in your Office Plus Basic Training folder 
within the Global Reports folder. 

 

 

Rounding syntax 

In Office Plus 10.5, a new rounding command is available for use when writing back to aggregated cells 
to control how many decimals end up in the leaf cells of the cube. This is useful when you want to plan 
how many whole units of something you want to sell.  

This option is not available in the Write Back dialog box. 

Examples using rounding 

Syntax example Explanation  

#E10[[0]] Distributes equally the new value of 10 and displays no decimals 

#E10[[2]] Distributes equally the new value of 10 and displays two decimals 

&W20[[2]]  Adds 20 to the cell value and displays two decimal places 

 

 

 

Demo: Write back rounding values to aggregated cells 

Your instructor will demonstrate how to use rounding syntax to write back rounding values 
to aggregated cells.  

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 5.3: Write back rounding values to aggregated cells 

In this exercise, you will use rounding syntax to write back rounding values to aggregated 
cells. 
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Exercise steps 

1. Open the <your initials> Ex 5.2 Report if it is not still open from the previous exercise.  

2. Type #E4000[[0]] in the Forecast field for Summer Tires.  

3. Press Enter. The value is distributed equally among the base elements of Summer Tires, and 
each base figure is rounded to a whole number with no decimals. As such, all base elements 
except the last one will get a value of 667, while the last element will get a value of 665. This 
distribution occurs in order to reach the total value of 4000.  

4. Type &W2500[[2]] in the Forecast field for Summer Tires.  

5. Press Enter. The value is distributed equally among the base elements of Summer Tires, and 
each base figure is rounded to two decimal points. 

6. Close the report without saving it. 
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Reallocation 

Reallocation is not a write-back method; rather, it is an option that can be used with the different write 
back methods.  

 In Ad-hoc reports and formula reports, reallocation commands open the Write Back dialog in 
reallocation mode.  

 In Alea Ad-hoc reports, reallocation commands open the Reallocator dialog box.  

Reallocation changes the values of base and consolidated elements without changing the value of their 
parents. You can enter a new value and specify where the difference between the old and new values 
should be allocated.  
 
 
Example: 

In an Ad-hoc report, your fourth quarter forecast for a year is 36000, to which October, November and 
December each contribute 12000. You want to change the forecast for the individual months without 
changing the overall forecast for the quarter.  

Type #W14000? in the cell for October. 

The Write Back dialog box opens with Weighted reallocation selected as the method. In the Reallocator 
section of the dialog box, select the Time hierarchy. November and December are listed as siblings.  

You can allocate to one or both siblings the 2000 difference between the old and new value. To allocate 
the difference to both siblings, select them both and click OK.  

The forecast for October is 14000 and the forecasts for both November and December become 11000. 
The overall budget for the quarter remains 36000.  
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Immediate and non-immediate write back 

Office Plus can be used in a reporting role or in a planning role. Planning requires the ability to write back 
different values to the database in order to see the effects and to save or discard the changes.  

In immediate write-back mode, changes are written to the database immediately. In non-immediate write-
back mode, values that you enter are cached and can be saved to the database or discarded by allowing 
you to revert to the current values stored in the database. Non-immediate write-back mode can be 
selected in any report based on the CELL.GET formula. However, it is typically only used in reports that 
were converted with the Excel-Aggregated option.  

You can toggle between immediate and non-immediate write-back modes in Formula reports by clicking 
the Non-immediate Writeback/Immediate Writeback button in the toolbar. 

To commit your changes to the database, click Save to database. To revert to the current values stored in 
the database, click Refresh from database. 
 

 

If you write back on a value that is calculated by Excel, the write back methods available in 
the Write Back dialog box are restricted to Weighted Distribution, Equal Distribution, and 
To each leaf.  

If you write back on a value that is calculated by the CELL.GET formula, all of the write-
back methods are available. 
 

 

 

 

Scenario: Enter data  

In this scenario, you will enter data into base and aggregated cells. As product manager, 
you are responsible for the sales planning in the UK for 2016.  

This scenario does not include detailed steps so that you have the opportunity to apply the 
knowledge and skills you have learned in this lesson and previous lessons. You are 
encouraged to experiment in this scenario as a means to better understand system 
behavior.  

For this scenario: 

 Create a base report for planning that shows your products together with the TIME dimension as 
rows.  

 Show both Sales Volume and Production Volume as columns.  

 Show monetary values in Local Currency.  

 Show budget values of 2015 and 2016. 

 Create the budget values of 2016 by augmenting 2015 values overall by:  
o 3 % for the Sales Volume  
o 2 % for the Production Volume  

 Save the report as <your initials> L5 Scenario Report. 
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Check your understanding 

 

 

Which of the following write-back commands are available for use in the Write Back dialog 
box? 

a) Weighted Distribution 
b) Rounding  
c) Equal Distribution 
d) To each leaf 

 
 
 
 

 

What is the result of rounding syntax #E8400[[2]] when it writes back values to aggregate 
cells? 

a) It increases each cell value by 84 percent, displayed as two decimal points 
b) It distributes equally a value of 8400 and displays cell values with two decimals 
c) It adds a value of 8400 to parent cells and reduces cell values to two decimals 
d) It subtracts equally a value of 8400 and displays cell values with two decimals 
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Lesson 6: Formula reports 

Estimated time 

2 hours 

Learning objectives 

After completing this lesson, you will be able to: 

 Identify the differences between ad hoc reports and formula reports. 

 Identify common Office Plus formulas. 

 Describe query-based, cell-based, Excel-aggregated, and value-based formula reports. 

 List the steps to convert an ad hoc report to a formula report. 

 Explain how to create a formula report from a blank Excel worksheet using the Formula Wizard. 

Topics 
 Ad-hoc reports vs. formula reports 

 Converting an ad hoc report to a formula report 

 Creating a formula report from a blank worksheet 
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Ad hoc reports vs. formula reports 

Ad hoc reports allow you to browse a database and provide an easy way to manipulate the dimensions 
and elements that display. For example, you can expand or drill down on data, swap or nest dimensions, 
or select elements using the List Designer. The data that is displayed within the report is constrained by 
the parameters of the ad hoc report and cannot incorporate native Excel functionality. 

Formula reports, however, are true .XLSX worksheets, and support Excel functionality. These 
customizable reports use formulas to pull data from a database into a worksheet. While formula reports 
can provide more control over the design of a report, they cannot do everything that an ad hoc report can 
do. For example, in a formula report, you can double-click slice dimension elements to change them, but 
you cannot expand or drill down on the value range dimensions like you can with an ad hoc report. 

 

Office Plus Help 
Formula Reports 

The following table provides a quick overview of how ad hoc and formula reports are created and the 
advantages and disadvantages of each: 

 Ad hoc report Formula report 

How to create Using the Ad-hoc Report Designer  Converting from an ad hoc or Alea ad 
hoc report 

 From an empty worksheet 

Advantages Allows for data analysis using the 
List Designer (dynamics included) 

 

 Allows for the use of Excel 
functionality 

 Individual modifications possible 

Disadvantages  Individual modifications not possible Limited dynamics of structure 

 
Why use a formula report? 

Formula reports allow for greater customization and control of the report. Instead of being limited to an ad 
hoc report template, formula reports can place data in specific areas of reports. They can also incorporate 
Excel functionality, combine data from different cubes or data sources, and include several worksheets 
within a single report - all tasks that ad hoc reports cannot perform. 

Office Plus formulas 

Formula reports use Office Plus formulas in addition to standard Excel formulas. The following table 
identifies some common Office Plus formulas and provides a brief description of each:  

Formula Description 

MEMBER.CNAME Returns the caption of an element, opens the member 
browser if double clicked. 

CELL.GETC Returns the value of an element 

KEY.GET Returns the last argument of a formula as string. 
(used to get the caption out of the unique name) 
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Formula Description 

AT.GET Returns the attribute for a specified element in a field of an 
attribute table 
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Converting an ad hoc report to a formula report 

You can create a formula report from a blank worksheet or by converting an existing ad hoc or Alea ad 
hoc report. Converting an existing ad hoc report is the easiest method for creating a formula report.  

You can convert ad hoc reports to four types of formula reports, including: 

 Query-based (MDX.EXECUTE) 

 Cell-based (CELL.GET) 

 Excel-aggregated 

 Values  

The query-based, cell-based, and Excel-aggregated reports differ in the type of formula by which the 
report values are calculated. In a values report, the values are displayed, but not calculated.  

 

Before converting an ad hoc report to a formula report, you should open the ad hoc report 
and configure it the way you want the formula report to appear. This should include rotating 
dimensions and selecting value range elements. 

Query-based formula reports 

Query-based formula reports have a dynamic structure that is saved in a single MDX.EXECUTE formula. 
This means that only one query needs to be sent to the database. You cannot write back data in an 
MDX.EXECUTE formula report. 

When converting an ad hoc report to a query-based formula report, the MDX.EXECUTE formula is hidden 
in columns A and B. In order to access the formula, you must unhide the columns. 

 

MDX.EXECUTE formula report 
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Cell-based formula reports 

In cell-based formula reports, each data cell contains an Office Plus CELL.GETC formula, or variation of 
CELL.GETC formula. Each formula requires a separate database query.  

A CELL.GETC formula reads the content of a data cell and each value is requested separately. 

You can write back data in a cell based report. The write back operation is handled by the server.  

Cell-based formula report 

 

Office Plus formulas require that elements are in a unique name format. In this form, the name of the 
element includes the dimension and the full hierarchy path. Each component is enclosed in square 
brackets [ ] and separated by a period. 

Because the CELL.GETC formula requires unique names as parameters, the slice dimension element 
names as shown cannot be used. They must be converted into unique names. 

It would be confusing to display unique names, as well as element names. Therefore, they are hidden, 
either by hiding the rows or columns, or by formatting the cell to not display any text as with the slice 
dimensions. 

 

Formula report with hidden unique element names 
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To format an Excel cell to not display text, use the Format Cells dialog box. 

Cell-based vs. query-based reports 

Deciding on the type of formula report to use depends on the needs of the application. Cell-based 
formulas can write back to the database, and can be more customizable because data cells can be 
placed individually. Query-based formulas, on the other hand, are faster, especially with large reports 
because only one query is being sent to the server. They are also more dynamic because changes to 
dimension elements will automatically be reflected in the data returned. However, you cannot write back 
to MDX.EXECUTE tables or control the layout completely.  

 

 

If you need the ability to do off-line calculations and/or non-immediate write back, then you 
will need the Excel Aggregated formula reports. 

Excel-aggregated formula reports 

An Excel-aggregated report is similar to a cell-based report, except that it uses Excel formulas in place of 
the CELL.GET formulas to calculate aggregated elements whenever possible. This means that 
aggregated elements are calculated in the spreadsheet instead of being called from the server.  

Excel-aggregated reports allow the user to enable non-immediate write back and offline calculations. 

 

Values formula reports 

A values report is a snapshot/copy of values in an ad hoc report. The values are not connected to any 
database anymore. As an example, you can use this to send a sheet of values to colleagues who don’t 
have an Office Plus license. 

 

 

Demo: Convert an ad hoc report to a cell-based formula report 

Your instructor will demonstrate how to convert an ad hoc report to a cell-based formula 
report. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
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Exercise 6.1: Convert an ad hoc report to a cell-based formula report 

In this exercise, you will convert an ad hoc report to a cell-based formula report. 

Exercise steps 

1. Double-click the <your initials> Ex 3.6 Report in the Report Catalog pane. 

2. Click Convert to Formula Report on the Ad-Hoc Report section of the toolbar to verify that Cell 
Based is selected. Otherwise, select Cell Based. 

3. Click the fx button on the Ad-Hoc Report section of the toolbar. Office Plus completes the 
conversion and a new window opens with the formula report. Because the report is cell-based, 
the unique names of the dimension elements are hidden in column C. 

4. Save the report as <your initials> Ex 6.1 Report in your Office Plus Basic Training folder 
within the Global Reports folder. 

5. Close the report. 
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Creating a formula report from a blank worksheet 

In addition to converting an existing ad hoc report or Alea ad hoc report, you can create a formula report 
by starting with a blank Excel spreadsheet. 

If you decide to create a report from a blank Excel worksheet, Office Plus provides a Formula Wizard to 
help insert Office Plus formulas. You can also use the Excel Formula dialog box or the Formula bar to 
insert and edit Office Plus formulas. 

 

By using drag and drop from the preview and the database pane, you can easily add 
database names and cube names to the spreadsheet. 

Using the Formula Wizard 

You can use the Office Plus Formula Wizard to insert formulas into a worksheet. 

 

 

Demo: Create a formula report using the Formula Wizard 

Your instructor will demonstrate how to create a formula report using the Formula Wizard. 

 

Demo steps  

1. Click New Formula Report. 

2. Drag and drop the Academy database from the Database Structure into cell A2. 

3. Drag and drop the SALES cube from the Database Structure into cell A3. 

4. Expand the SALES cube in the Database Structure to see its dimensions. 

5. Drag and drop the UNIT dimension into cell A5. The Insert Elements dialog box displays. 

6. Select Vertical as the Insert element list option. 

7. Confirm Unique Name is selected as the Output Format; otherwise, select it.  

8. Click OK. 

9. Expand the width of column A for better visibility of the values.  

10. Drag and drop the UNIT dimension into cell B5. The Insert Elements dialog box displays. 

11. Select Caption as the Output Format. 

12. Click OK. 

13. Right-click to delete any rows containing UNIT elements except for those with the following 
values:  

 Germany 

 Austria  

 Switzerland 



 

  Infor BI: Creating Reports and Analyzing Data with Office Plus Training Workbook 73 
   © 2015 Infor Education 

14. Type the values in the cells noted:  

Cell Value 

B3 Sales Volume  

C3 2012 

C4 Q1  

15. Right-click cell C5 to select Formula Wizard > Office Plus Formulas > Values > Cell.GETC. 
The Formula Wizard opens. 

16. Click Autofill.  The values for Database Alias, Cube, and the first element will be populated 
automatically. 

17. Click the ellipsis button next to the empty field to fill the value for the second element.  

18. Click the Time dimension.  

19. Click OK. 

20. Select 2012_Q1 in the Select Elements window.  

21. Click OK. 

22. Click the ellipsis button next to the empty field to fill the value for the third element.  

23. Click the Profit dimension.  

24. Click OK. 

25. Select Sales Volume in the Select Elements window.  

26. Click Finish in the Formula Wizard. You have created a formula that shows the value for Sales 
Volume in 2012 Q1 for GENESIS Germany. 

27. Expand the frame of cell C5 over cells C6 and C7. 

28. Press F9 to adapt the formula to cells C6 and C7 and display the values for GENESIS Austria 
and GENESIS Switzerland. 

29. Copy column C into column D. 

30. Change the value in D4 to Q2. 

31. Change the TIME portion of the formula in cell D5 from [20121] to [20122]. 

32. Press Enter. 

33. Expand the frame of cell D5 over cells D6 and D7.  

34. Press F9 to adapt the formula to cells D6 and D7.  

35. Hide column A. 

36. Add a total line to cell B8.  

37. Use AutoSum to total cells C8 and D8.  
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38. Format the cells using basic Excel functions, such as bolding headings. Your screen should look 
like the screen shot below. If it does not, review the previous steps and make the necessary 
corrections. 

 

 

 
 
 
 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
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Scenario: Working with formula reports  

In this scenario, you will create a report containing budget values, actual values and 
calculated variance values. 

This scenario does not include detailed steps so that you have the opportunity to apply the 
knowledge and skills you have learned in this Lesson and previous Lessons. You are 
encouraged to experiment in this scenario to find out the best way to receive the required 
result.  

 

Your report should look like the screen shot below. If it does not, review the information above or the 
appropriate steps in previous exercises and make the necessary corrections: 
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Check your understanding 

 

Briefly describe the differences between an ad hoc report and a formula report. 

 

_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 

 

 

 
 

 

Which of the following formula reports have a dynamic structure that is saved in a single 
MDX.EXECUTE formula? 

a) Cell-based 
b) Query-based 
c) Excel-aggregated 
d) Value-based 

 
 
 

 

Which toolbar button on the Ad-Hoc Report section of the Infor BI Office Plus toolbar 
converts an ad hoc report to a formula report? 

a) Options  
b) Tools  
c) fx  
d) New Formula Report  
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Lesson 7: Alea ad hoc reports 

Estimated time 

2 hours 

Learning objectives 

After completing this lesson, you will be able to: 

 List the steps to create an Alea ad-hoc report. 

 Explain how to use the Dimension browser. 

 Identify the buttons on the Dimension browser. 

 Describe the purpose of the Splasher. 

 Identify the Splasher toolbar buttons. 

 Explain how to insert a cell note. 

 Identify common Alea formulas. 

 Identify the differences between Alea and Office Plus formula groups. 

 Explain how to use Alea formulas in a report. 

Topics 
 Creating Alea ad hoc reports 

 Using the Splasher  

 Converting an Alea ad hoc report to a formula report 
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Creating Alea ad hoc reports 

Alea ad hoc reports are similar to ad hoc reports; however, they support different functions and formulas 
and can only be created on OLAP data sources.  

To create an Alea ad hoc report, do one of the following: 

 Click the New Alea Ad-hoc Report button in the Office Plus section of the toolbar. 

 Click the Cubes button on the toolbar and double-click a cube in the Cubes and Data Areas dialog 
box. This method enables you to base a report on a data area, as well as on a cube.  

 

 

To create Alea ad hoc reports, the OLAP Server add-in must be enabled. If you deselect 
the OLAP add-in you cannot create Alea ad hoc reports.  

To enable or disable the OLAP Server add-in, select Tools > Run OLAP add-in and then 
restart Office Plus. This tool is selected by default and enables Alea support in Office Plus.  
If you have problems enabling the add-in, you should add the install path of Office Plus to 
the Excel Trusted Locations.  

 

 

Office Plus Help 
Alea Formulas 

Using the Dimension browser  

You can change the view of the data by selecting different elements from the dimensions. To select 
elements from dimensions, click the Dimension in the Alea Ad-Hoc Report to open the Dimension 
Browser. You can use the Dimension browser to display single elements from each slice-dimension and 
multiple elements from each of the column and row dimensions.  

Dimension browser buttons 

The following table identifies the Dimension browser buttons and provides a brief description of each: 

Button Description 

Show Top-Level Elements  This button displays all elements that do not have any parents 
(usually the top-level elements of the dimension). 

Show All Elements This button displays all of the elements of the dimension in 
hierarchical or non-hierarchical order, depending on the display 
order. 

Key Query  This button analyzes the values in the dimension to find which 
elements will yield non-zero values in combination with the active 
elements of the other dimensions.  

This button is enabled only when the Dimension browser is 
opened from an Alea ad hoc report.  

Hide Lowest Level  This button displays hides all elements at the lowest level currently 
displayed, when in hierarchical view. 
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Button Description 

Show Next Level  This button shows all children of the elements currently displayed 
when in hierarchical view. 

Quick Selection   This button displays another toolbar with the following options:  

 Mark All Elements   Marks all elements displayed. 

 Remove Marks  Clears any marks. 

 Mark Elements without 
Parents 

 Marks all displayed elements that do not have any parents. 

 Mark Elements of a Given 
Level 

 Marks all elements at a specified level of the hierarchy. The 
number of buttons matches the number of levels in the hierarchy. 

Keep Marked Elements This button displays only elements that are marked. 

Cut Marked Elements This button removes the marked elements from the list of 
displayed elements. 

Undo This button undoes the preceding action. 

Find This button searches for elements or attributes and marks those 
elements that match the search. 

The Next/Previous buttons are enabled after a search and can be 
used to scroll through the result of the search. 

Flat View This button displays the dimension structure non-hierarchically. In 
flat view, the toolbar has additional buttons: 

 Sort 
Ascending/Descending 

 Sorts the displayed elements in ascending or descending order. 

 Hierarchical View  Resets the dimension structure to show elements hierarchically. 
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Using the Splasher  

In Alea-ad hoc reports and formula reports created from converting an Alea ad hoc report, the Infor BI 
Splasher must be enabled in order for a cell to allow data to be written back to the database. Splashing 
refers to the distribution of values according to a variety of rules.  

Because data is only stored in base elements, you cannot write back data to consolidated elements. 
However, with the Splasher, you can specify how values written back to base elements affect the 
consolidated elements they form. The Splasher uses non-immediate write back of data and analyzes the 
value and cell coordinates, as well as applies algorithms. This modifies the data of the base elements that 
define the input cell. For example, you can create a forecast for a year by increasing the values in a 
previous year by a specific percentage. 

 

If you try to enter a value in an aggregated cell when the Splasher is not enabled, a 
message will display informing you that you “cannot write to a calculated cell.” 

Splasher toolbar buttons 

The Splasher toolbar buttons are located next to the Database section of the toolbar and they are only 
visible when you are working with an Alea ad hoc report. 

The following table identifies the Splasher toolbar buttons and provides a brief description of each: 

Toolbar button Description 

Undo  Undoes the last splashing operation. 

Undo with Options This button opens a dialog box displaying a list of the recent splashing 
operations, which can each be selected and undone individually. The 
number of splashing operations that can be undone is specified in 
Splasher Options. 

Copy Values This button displays the Copy Values dialog box allowing you to copy 
data and structures from one data area to another. 

Options This button opens the Splasher Options dialog box allowing you to 
select the following options: 

 Enable splashing: Activates the splashing mode 

 Recalculate sheet after splashing operation: New calculation after 
each input splashing operation  

 Rounding: Calculated values are rounded  
Decimal Places: Number of decimal places used for the calculation 
(maximum: 6) 

 Error correction: Correction of rounding errors 

 Enable Undo buffer for: Activates the Undo and Undo with Options 
functions and allows a specified number of splashing operations to be 
undone 

 

 

Office Plus Help 
Infor BI Splasher – Writing Back in Alea Ad-Hoc Reports 
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Using cell notes 

Alea ad hoc reports support cell notes. In the Cell Note Editor, you can add notes to the data cells of Alea 
ad hoc reports created on the BI OLAP database.  

To insert a cell note, double-click a data cell to display the Cell Note Editor and enter the desired text. 

In Alea ad hoc reports, cells that contain notes are indicated by a red triangle in the upper-right corner 
and the note is displayed as a tooltip. 

 

 

Demo: Create an Alea ad hoc report 

Your instructor will demonstrate how to create an Alea ad hoc report. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 7.1: Create an Alea ad hoc report 

In this exercise, you will create an Alea ad hoc report. 

Exercise steps 

1. Create a new Alea ad hoc report from the SALES cube with the following specifications: 

Row Dimension   UNIT 

Column Dimensions  

 

 VERSION 

 CURRTYPE 

Slice Dimension 
Selections 

 TIME 

 2012 

 PRODUCT 

 Car Tires All Season 

 PROFIT 

 Gross Margin 

2. Double-click the G0000 Unit dimension to drill-down to the child cells of G0000.  

3. Double-click the C1100 child cell to display the base cells. Note: It is not necessary to double-
click on C1200 because all base cells have 0 values. 

4. Click the ellipsis button next to the UNIT dimension.  

5. Select Zero suppression.  

6. Click OK. 
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7. Click the Version dimension.  

8. Clear the check boxes for all values except Actual and Budget.   

9. Click the Keep Marked Elements (green check mark) button. 

10. Click OK. 

11. Click on the CURRTYPE dimension.  

12. Clear the check box for Local Currency. 

13. Click the Keep Marked Elements (green check mark) button. 

14. Click OK. 

15. Click on the UNIT dimension. The UNIT dialog box opens.  

16. Click the Attribute button in upper-left corner of the display (below the toolbar).  

17. Select Attribute Table 1.  

18. Click the Configure Columns button on the far right of the toolbar. The Configure Columns 
dialog box opens. 

19. De-select all Attribute column names except the Name column.  

20. Click OK.  

21. Click OK in the UNIT dialog box. The UNIT elements list now displays the proper element names.  

22. Save the report as <your initials> Ex 7.1 Report in your Office Plus Basic Training folder 
within the Global Reports folder. 
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Converting an Alea ad hoc report to a formula report 

Just as you can convert an existing ad hoc report to a formula report, you can also convert an existing 
Alea ad hoc report to a formula report. A converted Alea ad hoc report is simply a formula report that 
includes Alea formulas. Formula reports, as you have already learned, support Excel functionality. Values 
in formula reports that are converted from Alea ad hoc reports are calculated by different formulas from 
those in reports that are converted from ad hoc reports.  

You can convert Alea ad hoc reports to three types of formula reports, including: 

 DBGETC – clustered 

 DBGET 

 Values  

A DBGET formula reads the content of a data cell and each value is queried separately. A DB.GETC 
formula reads the content of data cells and the requests are bundled in a cluster algorithm. 

The difference between DBGET and DBGETC is that DBGETC groups all of the DBGETC formulas in a 
report into one database request. Therefore, DBGETC generally returns results faster than DBGET. You 
can write back data in DBGET and DBGETC formula reports. 

In a Values report, the values are displayed, but are not calculated by any formula.  

Alea formulas 

Alea formula reports use Alea formulas in addition to standard Excel formulas. You can use the Alea 
Formula Wizard to insert Alea formulas, such as the DBGET and DBSET formula families, which read 
values from, or write values back to a cube. 

The following table identifies common Alea formulas and provides a brief description of each:  

Formula Description 

DE.NAME Returns the name of a dimension element; opens the 
Dimension browser when double-clicked 

SE.CNAME Returns the name of an element in a subset, opens the 
Dimension browser when double-clicked 

AT.GET Returns the attribute of the specified element from a field of 
the attribute table 

AT.SET Writes information for the specified element in the field of 
the attribute table 

 

Alea and Office Plus formula groups 

The following table identifies similar Alea and Office Plus formula groups:  

Alea Office Plus 
DBGET(x) CELL.GET(x) 
DE.NAME MEMBER.CNAME 
AT.GET MDX.GET 
AT.SET - 
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Alea Office Plus 
AT.HEAD - 
NGET, NSET - 

 

 

Alea formulas use simple names (captions) of elements, unlike Office Plus formulas, which 
use unique names. 

 

 

 

Demo: Convert an Alea ad hoc report to a formula report 

Your instructor will demonstrate how to convert an Alea ad hoc report to a formula report 
and then use Alea formulas in the report. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 7.2: Convert an Alea ad hoc report to a formula report 

In this exercise, you will convert an Alea ad hoc report to a formula report and then use 
Alea formulas in the report. 

Exercise steps 

1. Open the <your initials> Ex 7.1 Report that you saved in the previous exercise, if it is not 
already open.  

2. Click the Convert to Formula Report button on the Alea Ad-Hoc Report section of the toolbar. 

3. Select DBGETC - clustered. 

4. Click the fx button. Office Plus completes the conversion and a new window opens with the Alea 
formula report. Each cell of the converted report is populated by the selected formula.  

5. Click in any cell with a value (e.g. B37) to see the formula displayed in the Excel fx (formula) bar 
that displays above the data. 

6. Insert two columns to the end of the existing table.  

7. Type the following formula in cell G39 to calculate the variance between Actual and Budget for 
EUR values:  

 =C39-E39 

8. Click and drag the corner of cell G39 over the remaining value cells in column G to apply the 
formula to those cells.  
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9. Type Variance EUR in cell G38 to label the new column.  

10. Type the following formula in cell H39 to calculate the variance between Actual and Budget for 
USD values:  

 =D39-F39 

11. Type Variance USD in cell H38 to label the new column.  

12. Click and drag the corner of cell H39 over the remaining value cells in column H to apply the 
formula to those cells. 

13. Right-click in cell D31 display the shortcut menu.  

14. Select Formula Wizard > Alea Formulas > Attributes > AT.GET to insert the formula. 

15. Specify the following parameters for the formula in the Formula Wizard dialog box: 

Field Data 

Database Alias  Academy 

Dimension PRODUCT 

Attribute Table ID 2 

Element C31 

Field GERMAN  
 
Note: This displays the German name of the selected Product. 

16. Click Finish in the Formula Wizard. 

17. Double-click Car Tires All Season in the Slicer area to open the Product dialog box.  

18. Double-click Car Tires Summer in the Product dialog box. The table shows all values for 
Summer Tires and it added the German name for the selected tires. Note: If you did not achieve 
these results, verify or do the following:  

o Click the Options menu in the Infor BI Office Plus tab. The Options dialog box opens. 
o Click the Calculation tab.  
o Select Recalculate Alea Ad-hoc reports automatically.   
o Click OK. The Options dialog box closes. 
o Select File > Options. The Excel Options dialog box opens.  
o Select Formulas.  
o Select Automatic under Workbook Calculation in the Calculation options section.  
o Click OK. 
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19. Verify that your screen looks like the screen shot that follows. If it does not, review the previous 
steps and make the necessary corrections. 

 

20. Save the report as <your initials> Ex 7.2 Report in your Office Plus Basic Training folder 
within the Global Reports folder. 
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Check your understanding 

 

 

When creating Alea ad hoc reports in Infor BI Office Plus, what button in the Dimension 
browser displays all elements that have no parents? 

a) Show Top-Level Elements 
b) Show All Elements 
c) Key Query 
d) Hide Lowest Level 

 

 

 

Alea ad hoc reports can be converted to which of the following types of formula reports? 
Select all that apply. 

a) DBGETC - clustered 
b) DBGET 
c) Values 
d) MEMBERC.NAME 

 

 

 

Which feature allows you to add notes to the data cells of Alea ad hoc reports created on 
the BI OLAP database? 

a) Cell Note Manager 
b) Cell Note Editor   
c) Data Cell Editor 
d) Options Editor 

 

 

 

Which of the following Alea formulas is used to return an attribute of the specified element 
from a field of the attribute table? 

a) DBGET(x) 
b) AT.GET 
c) DE.NAME 
d) CELL.GET(x) 
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Lesson 8: Using other Office Plus 
features 

Estimated time 

1 hour 

Learning objectives 

After completing this lesson, you will be able to: 

 Describe the use of a global list in a report. 

 Explain how to use a calculation in a report. 

 Explain how to use the Style Wizard to create a new template. 

 List the steps to apply a template to a report. 

Topics 
 Global Lists 

 Calculations 

 Style Wizard 
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Global lists 

Lists in the Database Structure are global lists that are valid for an entire report catalog. When they are 
inserted into reports, these global lists are copied into local lists, which are valid only for that report. 
Global and local lists can be designed independently. 

To create a global list, right-click a hierarchy or dimension in the Database Structure pane and select New 
> Global List. To use a global list in a report, drag the list from the Database Structure pane on to the 
worksheet. 

 

 Global lists are stored in the OLAP database. 

 Users will need the appropriate rights to be able to add Global lists. 

 All users will be able to see the Global lists created in an OLAP database. 

 

 

 

Demo: Create and use a global list 

Your instructor will demonstrate how to create and use a global list in a report. 

 

Demo steps 

1. Right-click the UNIT dimension in the SALES cube in the Database Structure pane.  

2. Select New > Global List. 

3. Name the global List DACH. DACH is a country group containing the countries D, A and CH. 

4. Double-click the DACH Global List to open the List Designer and Structure Selection panes. 

5. Select the following base elements: 

 GENESIS Germany GmbH 

 GENESIS Austria GmbH 

 GENESIS Switzerland AG 

6. Click Apply changes to the list. 

7. Create a new ad hoc report from the Sales cube. 

8. Drag UNIT to the rows. 

9. Drag the DACH Global List from the Database Structure pane on to the worksheet to replace 
the UNIT dimension. Only the elements defined in the Global list will be displayed. 
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______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
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Calculations 

A calculation is an element that is calculated when you open a report. Calculations are displayed in the 
List Designer and can be selected as list elements in the Structure Selection pane.  

Calculations can also be displayed and created in the Database Structure pane. To display calculations in 
the Database Structure pane, click the Options button on the toolbar and select the Show Calculations 
check box in the Database Structure Options dialog box.  

To use a calculation in a report, drag the list from the Database Structure pane on to a dimension in the 
worksheet. The calculation will automatically be used in new reports that include that dimension. 

 

 

 Calculations are stored in the OLAP database. 

 Users will need the appropriate rights to be able to add calculations. 

 All users will be able to see the calculations created in an OLAP database. 

 

 

 

Demo: Create and use a calculation 

Your instructor will demonstrate how to create and use a calculation in a report. 

Demo steps 
 

1. Click the Database Structure Options folder button on the toolbar in the Database Structure 
pane. The Database Structure Options dialog box opens. 

2. Select the Show Calculations check box in the Database Structure Options dialog box.  

3. Click OK. 

4. Expand the TIME dimension in the Database Structure pane.  

5. Expand the TIME hierarchy.  

6. Right-click the Calculations folder to select New > Calculation.  

7. Type First half of 2012 over the New Calculation label to change the name of the calculation. 
The Edit Calculation dialog box opens. 

8. Double-click the 2012_Q1 element to add it to the right pane. 

9. Type + at the end of the formula that displays in the right pane. 

10. Double-click the 2012_Q2 element to add it to the right pane. The new calculated element will be 
the sum of elements 2012_Q1 and 2012_Q2. 

11. Click OK. 

12. Create a new ad hoc report from the Sales cube. 

13. Notice that the new First half of 2012 calculated element is automatically listed under the TIME 
dimension showing the values for the first half of the year 2012. Note: The new calculated 
element can be removed from the list using List Designer. 
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Style Wizard 

When you create an ad hoc report, you can use a template to manage the fonts and colors used in the 
report. Or you can format the report manually. By default, if you use a template, the Standard template is 
applied. The Style Wizard is used to create and edit templates for ad hoc reports. 

Each step of the Style Wizard asks you to specify the font, font color and background of the different 
components of a report (for example, headers, columns, rows).  

To use a template style in a report, click Options in the toolbar to display the Ad-hoc Report tab of the 
Options dialog box. Select the Use template check box and click the Browse button to browse to the 
template to use.  

 

 

Demo: Create and use a template 

Your instructor will demonstrate how to create a template using the Style Wizard and then 
apply the template to a report. 

 

 

______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 
______________________________________________________________________ 
 

 

 

Exercise 8.1: Create and use a template 

In this exercise, you will create a template using the Style Wizard and then apply the 
template to a report. 

Exercise steps 

1. Select Tools > Style Wizard in the Extras group. The Office Plus Style Wizard opens. 

2. Verify that New Style is selected. Otherwise, select it. 

3. Click Next. From this screen, you can specify the font, font color, and background color of the 
report headers. 

4. Click the Font button. The Font dialog box opens. 

5. Select Times New Roman from the Font list. 

6. Select 14 from the Size list.  

7. Click OK. 

8. Click the Font Color button. The Color dialog box opens. 

9. Select <a color>.  

10. Click OK. 

11. Click the Background Color button. The Color dialog box opens. 
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12. Select a color.  

13. Click OK. Notice a preview of the report header displays in the Office Plus Style Wizard. 

14. Click Next.  

15. Select the fonts and colors for the Column 1 heading.  

16. Click Gradient to lighten the color gradually from dark to light across the report.  

17. Select the Identical for Rows and Columns check box to apply the same formatting to the row 
headings.  

18. Click Next. Note: If you did not select the Identical for Rows and Columns check box, a screen 
will display allowing you to format the row headings. 

19. Specify the font, font color, background color, and number format to apply to the data in the 
report.  

20. Click Next.  

21. Select the font, font color, and background color of the non-data area. The non-data area is 
defined as the adjacent area to the data area of a report that has only one column or one row. 

22. Click Next.  

23. Select a default style for the remaining areas of the report; as in, those areas not formatted in any 
of the previous steps.  

24. Click Next. 

25. Select the number format of any currency, percent, and the short date or short time values in the 
data area.  

26. Click Next.  

27. Specify the colors and gradients to use in exception reporting.  

28. Click Next.  

29. Click Finish. The Save Formula Report As dialog box opens. 

30. Select My Desktop as the Report location.  

31. Type <your initials> Ex 8.1 Template in the File Name field. 

32. Click Save.  

33. Click Yes when the Close Workbook dialog box displays.  

34. Click the Report Catalog button.  

35. Right-click Templates in the Report Catalog pane.  

36. Select Import.   

37. Select the <your initials> Ex 8.1 Template from the Desktop to import your template. 
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Scenario: Use other Office Plus features 

In this scenario, you will create an ad hoc report with the Sales cube, create a sales 
calculation, and show the calculation in the report. As final steps, you will apply a template 
to the report and then save the report. 

This scenario does not include detailed steps so that you have the opportunity to apply the 
knowledge and skills you have learned in this Lesson and previous Lessons.  

 Create a new ad hoc report for the SALES cube for January 2012. 

 Create a Net Revenue Per Sales calculation using the following formula:  
o [PROFIT].[Gross Margin].[Net Revenue] / [PROFIT].[Sales Volume] 

 Show the new calculated element as a column in the report, together with Sales Volume and Net 
Revenue. 

 Your report should look like the screen shot below. If it does not, review the information above or 
the appropriate steps in previous exercises and make the necessary corrections: 

 

 

 Apply the <your initials> Ex 8.1 Template to the report. 

 Save the report as <your initials> L8 final scenario in your Office Plus Basic Training folder 
within the Global Reports folder. 
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Check your understanding 

 

 

Which of the following is used to create and edit templates for ad hoc reports in Infor BI 
Office Plus? 

a) The Formula Wizard 
b) The Cube Wizard 
c) The Style Wizard 
d) The Template Wizard  
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Course summary 

Estimated time 

30 minutes 

Course objectives 

Now that you have completed this course, you should be able to: 

 Identify the basic features and functionality of Office Plus. 

 Explain how to log on to Office Plus and identify the main components of the user interface. 

 Describe how to create ad hoc reports and browse through data. 

 Explain how to use the List Designer to select, sort, and filter data. 

 Explain how to write values back to base cells and aggregated cells. 

 List the steps to create formula reports. 

 List the steps to create Alea ad hoc reports.   

 Explain how to use attribute tables, global lists, calculations, and style templates. 

Topics 
 Course review 
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Course review 

 

 

 

What are five methods for manipulating the display of data in an ad hoc report? 

 

________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________ 

 

 

When writing back values to aggregated cells, what does selecting the percent option for 
the equal distribution method do? 

 

_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 

 

 

 

What are the three basic types of Office Plus formula reports? 

 

_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
 
_______________________________________________________________________ 
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When sorting data, what does the Break Hierarchy feature do? 

 

________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________ 
 
________________________________________________________________________ 
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